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About the Manual and Help System

Xact is a professional tool for the graphic presentation of all types of data.

Linked to this are a considerable number of functions, some complex, which we

shall try to show you as clearly as possible in this manual.

We have therefore deliberately designed this slim manual with two aims in

mind: firstly to get you started on completing your initial chart quickly (in the

next section), and secondly so that you can understand the principles and

techniques of using Xact.

The Overview Sections each offer an introduction to the topics they deal

with and are intended to give you a general picture. The Example Sections have

been conceived as practical exercises and you should work through these on

your computer.

You will find the full documentation (the Reference Section) to Xact in the

Online Help (electronic help system). The Online Help in Xact is context-sensi-

tive and very detailed; it also contains various practical tips. We therefore

strongly recommend that you use the Online Help intensively. On the

next few pages you will find a brief introduction on using the Online Help.

The Online Help allows fast access to the desired information, is regularly

updated and produces no litter. Those who prefer printed information can print

out this Online Help – the help system makes this easy. However, you should be

prepared for the approximately 700 sheets of paper that you will need.

The help system is less well-suited as an initial introduction because rea-

ding from the screen is hard work, and it is often difficult to view the text and

program at the same time on small screens. And that is precisely why you are

holding this manual.

Both the manual and the help system deal with Xact versions for MS

Windows 3.1, Windows 95, Windows NT and IBM OS/2. The Xact versions differ

optically, e.g. in the 3D effects of the dialog boxes, as nothing can stand in the

way of the relentless march of ”fashion”. Nevertheless, you should still be able

to find your way around.
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Quick Start

Are you someone who prefers to put software manuals in the bookshelf

unopened and go straight over to the program? Please try at least to read the

section entitled Quick Start… and the Overview sections and also learn about

the help system on this page so that you properly understand how Xact works

and can fully exploit the program!

Systematic learning

If you would rather get to know Xact thoroughly, simply read the manual

from start to finish. In any event, you should try out the exercises on your

computer as you go along. If you find the subject matter of some sections less

appealing, you should at least skim through them as they also contain general

information on how Xact works!

How you can ask Xact questions - the help system

Many computer users flatly refuse to work with help systems. And they

often have good reasons for doing so: help systems are only helpful if they

function in a context-sensitive manner, contain sufficient cross-references and

have a detailed index.

Context-sensitive help systems show you information on the topics you are

working on at any given time. If for example you have just opened a complex

dialog and do not understand what is being described, in a context-sensitive

help system you click on Help… and are given some explanations. You can then

obtain further information with clicks on the cross references. If you cannot find

a function, the Help Index lists a large number of important keywords that will

guide you directly to the important parts of the text.

Whenever you have questions on functions in Xact, use the Xact help

system! There are various routes to the help system:

• In graphics or table windows you can access the help system in the Window

menu

• While you are working with Xact, context-specific help is readily available,

and you will therefore find a button labeled Help… in every dialog.

• The F1 key always opens the help system and gives you context-sensitive in-

formation.
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In principle help systems are organized like books with a table of contents

and an index. In some books you find cross-references to other sections or pages

in the book, and exactly the same is true of help systems. Here cross references

in the text are marked in color and branch off to the relevant sites at the click of

a mouse. You can return to passages you have previously selected with Back or

Previous topic.

One enormous benefit of context-sensitive help systems is their great ease of

access. With printed documentation you have to search for explanations to

terms in dialogs for example; here a mouse-click on the Help button in the dialog

is enough. The help system then gives a direct display of the relevant explana-

tions.

In connection with Help you will find three entries in the Window menu:

• under Help you will find an article that matches your current activity within

Xact

• under Help index you can search by keyword

• under Table of contents, as in a book, you will find a structured list of what

the Help section contains.

The help system for MS Windows

Start Xact and in the Window menu select Table of contents. The window

that now opens has four entries:

• File: Print topic enables you to print the section in question

• With Printer Setup you can adjust your printer. Open lets you load any help

file, End closes the help window.

• Edit enables you to copy the text and to add any comments.

• ? gives you assistance in using the help system.

You will find a number of buttons under the menu bar:

• Contents shows the list of contents for this electronic book. You will find un-

derlined entries in the window. A double-click with the left-hand mouse but-

ton on the underlined text will open the first page of the relevant section. In
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each section you will find cross references to further sections (underlined

words) or explanations of terms (words with a dotted underline). You can

view the explanations by clicking on the word once with the mouse button.

• Back takes you to the previous section or to the table of contents.

• History lists all the sections you have selected to date and thus allows you to

simply jump over several sections at a time.

• ·Search gives you a list of all the Section Titles in the help system containing

the word entered. The Go to button opens the relevant section.

The help system for OS/2

Start Xact and in the Window menu select Table of contents. In the menu

bar of the window that opens you will find three entries:

• Functions : Search... opens the dialog of the same name (see explanation

further down), Print... offers you various options for printing help pages. With

the other entries you can copy section contents from the help system and pa-

ste them into other documents.

• Options offers you further ways of working with the help system. These have

been described in detail under the menu option Help in Help for help functi-

ons.

The Table of Contents for Xact is now shown in a window. You will find a

cross in front of some entries. Click on the cross and more sub-headings for each

section title will be shown and the cross turns into a line. A click on the line will

then close the sub-heading again.

A double-click on an entry in the table of contents opens the relevant

section. Within a section you will find words highlighted in blue. A double-click

on these words will bring you to further sections.

At the lower edge of the window you will find four buttons:

• Previous topic lets you go back one section.

• Search... opens a dialog for entering a search string. You can then look for

this search string in different areas of the Xact help system, and also in all

the help libraries on your computer. The contents of all sections are included

in this search. As a full text search is possible here, typing in the search
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string *X* for example will give you all words that contain an X, such as

”Xact” or even ”example”. The search result you obtain is in the form of a

list of the sections containing the hits. If you open a section from this list, the

words found will be highlighted in red.

• Print... lets you print out parts of the help or the entire system.

• Index shows the Xact help index in a window.
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Preparations

First steps - starting Xact

When you first start Xact after a new installation by double-clicking the Xact

icon (or Xact.exe), three windows are opened automatically. Xact will always

start with these windows because the entry Autostart window is set in the

windows.

In the background you’ll see a window showing the previews of a all Xact

Graphics windows of a directory on your hard disk. This window is called a

Graphic Explorer window and makes working with already existing graphic

windows easy (see below). On top of it you’ll see two table windows (see below)

ready to create charts from its data.

To switch the Autostart feature off uncheck the entry Autostart windows: you

will find it in the context menu of a Graphics Explorer window or in the File

menu in other windows.

If you are bursting with curiosity: goto the Chart menu of one of these table

window and click on Lines... . In the dialog choose Lines/Marker and click on

OK to create your first chart with Xact. This chart is created in a new Graphics

window Xact opens for you. If you now move the mouse pointer over the chart

you’ll see the shape of the mouse pointer changing from arrow to cross, depen-

ding on the object it points to. The cross pointer indicates that you can change

properties of an object. Open the context menu in this position to see what you

can change - and in any case at least read the chapter Quick start - from

data to chart in this manual to get an overview on what you can do!

Window types used in Xact

In Xact you can work with different types of windows:

Table windows contain data and text you need to create charts. This window

type has the extension “XTF” and uses menus and context menus to work with,

for more information see the chapter “The table window”.
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Graphics windows contain graphic objects and charts (consisting of graphic

objects). This window type has the extension “XGF” and uses menus and

context menus to work with, for more information see the chapter “Drawing &

Illustrating”.

Graphic Explorer windows let you see the previews of all Xact graphic

windows in a directory, making working with many graphics windows and

linked tables very easy. Each Graphic Explorer window (extension “XGE”) has

a title consisting of path and file name. It shows the previews of all Xact

Graphic files (*.XGF) in the path given in the title. The shown previews are

normalized in size. This enables you to identify small graphics as well as large

graphics.

Graphic Explorer windows are managed only by context menus. Graphic Explo-

rer windows can be sized as common resulting in a new distribution of the

previews. To work with the shown files you must first select them using the

mouse or keyboard. Selected files are shown inverted.

Open the context menu by a context click on one of the shown previews. The

entries in this menu are more or less the same as in other Xact windows. Some

important entries:

• Actualize: actualizes the previews shown in the window.

• Select/Deselect all: this entry changes after a selection in the window.

• Sort by Name/Date: this entry changes the sort mode of the window.

• Selected windows: the entries following this text in the context menu are only

accessible, if a preview is selected.

• Open with linked table windows: opens all selected graphic files with all their

linked tables tables.

• Open linked table windows...: creates a list of all selected graphic files and

their linked tables. Click on a name to open the file. If linked table windows

are not found - always after a new installation of Xact - the table name is se-

arched in the path of the graphics file it belongs to (Message: Path of graph-
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ics file). If the table name is not found there, it is searched in the actual table

path (Message: Found in + path). If it is not found there, the given message

is “File not found”.

• The entries Print..., Export..., Delete work on all selected graphic files.

• Autostart window: A checkmark shows the actual state. Can be set for all

Xact windows by clicking on the entry, in graphics- and table windows in the

menu “File”. But: In “Prefe-

rences/System” the radio but-

ton “Marked or last used win-

dow” must be set! All set auto

start marks for all windows

can be deleted by a click on

the entry “Delete all autostart

marks”: in graphics and table

windows in the menu “Win-

dow”, in Graphic Explorer

windows in “Options” in the

context menu.

Drag & Drop of files with Graphic Explorer windows:

- from Windows Explorer: drag the wanted files from Windows Explorer to Xact

Graphics Explorer and release the mouse key. The files are inserted in the

window and physically copied (not moved!) to the path given in the title.

-between Xact Graphic Explorer Windows: drag the selected previews from one

Graphic Explorer Window to the other. Release the mouse button: the Xact

Graphic files are copied (not moved!) to the directory given in the title. But be

aware: Linked tables are NOT COPIED! The pathes to the linked tables

remain the same, after a graphics files was

copied.
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Preferences...

In the File menu you will find the Preferences... option which provides you with

several dialogs in which you can largely specify the standard settings for Xact.

The basic behavior of Xact is laid down in the Preferences. The settings made

here apply to all the windows that are subsequently opened. They are saved

when Xact is closed. Let us take a brief look:

As there are a lot of settings summarized in a very compact space, simply

browse through the pages and read up on the functions using the Online Help.

We shall briefly discuss the most important of these basic settings here: now

open a graphics window with command New... in the File menu. You will also

find that your settings are in the Page menu of the window under Format.

Preparations

If you want to draw something, you first reach for a sheet of paper and get the

necessary utensils ready. There is a similar procedure in Xact: first of all you

specify the page format, decide on the system of measurements and rulers, etc.

In Xact this happens the moment you open a chart or create a new one. Xact will

first use the information saved in the Preferences (File menu). You can find full

information on these settings in the Online Help !

The settings saved under Preferences are then used for all charts that you open

with the option New… in the File menu, or for the charts opened automatically

by Xact.

You can adjust most of the settings individually for the newly opened graphics

window in the Page menu!

Page format and measurements system

You specify the format of a page (here the graphics window) in the Preferences

on the Graphics editor page using the Page format option.

• In the File menu select the Preferences option and then the Graphics editor

page in the notebook that appears.

• Click on Page format… .
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• In the dialog shown below you can now select the Page format, the orientation

and the System of coordinates.

All the positions, lengths and widths will be indicated by Xact in the units of

measurement that you specify in the Page format dialog. You can choose to

work in centimeters, millimeters, inches or other units depending on the appli-

cation or your own personal preferences.

• Click on the field after Measuring unit and select Centimeters (cm) as the

unit.

Replacing fonts

When reading a XGF file, Xact can replace any fonts that are not present in the

system by other fonts. The replacement table for this is called XGFMAP.TXT

and is located in the same directory as Xact. You can change and add to it

yourself; you will find further information in the Online Help under Replace

fonts.

If the box for Write log-file is checked on the System page of Preferences, each

time an XGF file is loaded, the event will be recorded in a file (*.LOG) written

into the directory of the loaded XGF file. It contains a list of the replacements

that have been made (see Online Help)

• When fonts are replaced, the lengths of the replacement font do not

usually match those of the original. As a result, errors occur in the

graphics document, which - if there is a lot of text - will be difficult to

discover.

• If you want to find out exactly how the font-names are written in Xact, you

can click on the Write font-list button on the System page of Preferences. Xact

then writes a list with the names: FONTLIST.TXT. You can find further in-

formation in the Online Help and in the file itself.

Create backup

If this option on the Graphics editor page of Preferences... is checked, when a

graphics file is saved, the extension of the previous version will be changed to

*.XG~ .
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Around and about the graphics window

Let us have a short look at the Page menu of a graphics window:

Color spaces Here you can choose between the models RGB, CMY, HSV

and - if you own XactPro - CMYK.

Rulers Xact displays rulers at the top and left-hand edges of a

graphics window. They may be compared with the rulers on a

drawing board. They are graduated according to the measu-

ring unit you have selected. To save space, no rulers are

displayed when a chart is first opened. You can show or hide

them whenever you want using the Show rulers option in the

Page menu.

Grid Xact offers you another orientation aid in the form of the

Grid , which is comparable to graph paper: so that your win-

dow is not littered with grid points, Xact only displays every

10th grid horizontal and vertical grid line if the spacing is very

narrow. The interval between grid points can be freely defined

but should not fall below 0.1 mm. As the grid is purely inten-

ded as a drawing aid, it is ignored in the printout.

Show grid The grid can be activated and deactivated by clicking the

Show grid box at the lower edge of the window.

Grid settings By selecting Grid options… in the Page menu, you can

define the distance between the grid points. If you check Ma-

gnetic grid, when you move objects, they will attach themsel-

ves to the nearest grid point. When you are drawing too, points

can only be set at grid points.

Relative grid If an object does not begin on a grid point, it will jump to

the next one as soon as it is moved. During scaling, the absolu-

te grid functions in the same way. This may be desirable when

you are drawing, but can be very disruptive when your are

working with charts. For this reason, if you select Relative

grid , the object will not jump from grid point to grid point, but

will simply be moved from its original position by the distance

specified for the grid spacing.
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Outline mode for greater speed

A computer generally draws lines more quickly than solid

2D objects. If you find redrawing complex charts occurs too

slowly, you can check the Outlines only switch in the status bar

at the bottom of the window and thus change to the so-called

outline mode. In this mode only the edges of the individual

objects are drawn, which considerably speeds up the display

and also makes it easier to select hidden objects.

Even objects that have no frame, will be displayed as fra-

mes in the outline mode. The outline mode has no effect on the

printout.

How the tool bar works

The way the toolbar functions varies according to the tool

being used. Detailed information is given in the chapter Dra-

wing & Illustrating.

The drawing functions – from the rectangle to the text

object – and the pipette switch themselves off once the functi-

on has finished. This is shown by the fact that the arrow

symbol is reactivated. However, if you now press the space

bar the function that was last used will be repeated . In this

way you can quickly draw a series of different rectangles by

pressing the space bar once after each rectangle.

If, on the other hand, you want to draw several objects

consecutively, without having to press the space bar inbet-

ween, you can check Keep drawing tool on the Graphics editor

page of Preferences . The drawing function you last selected

will then be retained until you click on another symbol with

the mouse.

The functions for editing , cutting and rotating objects

are retained until you click on another symbol in the toolbar,

another object or the background of the graphics window.
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How the drawing functions work

You can use the drawing tools to create objects with optical

characteristics that can be changed at any time. Whenever

you create a new object, the optical characteristics depend on

the settings in the Object menu. A new rectangle will therefore

take on the settings that have been entered in Line/frame…

and Fill style… .

How to manipulate the various individual tools is described in more detail in

the section entitled Creating objects.
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Quick start – from data to chart

This section shows you the typical procedure for creating a chart. To put it

briefly, you will be given a rough overview of the steps ”from data to chart”. In

the table editor you collect and edit the data, with the chart functions you

edit the charts and with the graphics editor you alter their visual appearance.

You will find more information on the individual types of chart and the functi-

ons of Xact in this manual and in the Online Help.

You will find more detailed information on working with the graphics editor in

the section entitled Drawing and Illustrating.

Data
Charts

editing

Working methods for

Tables

editing

Illustrating

and editing

la
be

lli
ngpublishing

- artwork

charting with Xact:

- slides
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In the Beginning there was the Number – The Tables

Your figures are the starting point for your work. If the data are already

available as files, the first step is to load them into the table editor. The table

editor window is like that of a spreadsheet. There you will find your data

arranged in rows and columns. However, if your figures are not available on

electronic storage media, you can also enter the data directly into the table

editor.

Within a table you can choose any desired areas for graphic display. Xact has

various methods of selecting data: the simplest is to select an area by moving

the mouse while keeping the left-hand mouse button depressed. You can alloca-

te the figures to the various axes of the graph. In the table editor Xact works on

the basis of columns: you therefore mark each column as Y columns, X columns,

etc. This step is called defining column types – you can read up on this in the

section entitled The Table Editor and in the Online Help!

You save the completed table in the Xact table format (*.XTF). The column

definition is also saved with this type of table file and is then available for

repeated use.

Creating Charts

After selection and allocation comes the second step: in the Chart menu

select the desired style of chart, e.g. Bars… A dialog box will then open up in

which you can choose between further subtypes. At this point you can also

decide in which document the chart is to be drawn. You can draw as many

charts as you wish within one document. If no document is open, Xact opens a

graphics window and draws the chart there according to the default settings

(File menu).

The charts themselves consist of graphical elements, which are assembled into

a series of groups – see the Figure ”Chart Groups”. To explain this, we have

taken a chart apart here. In the center are the graphs: here you can find a

single row of bars and a ribbon. You can then see three axes, as well as the title

groups above the chart, the legend groups on the right-hand side and – on a

3D chart – the walls and the base, too.

Each of the named groups has its own chart functions to change the proper-

ties of that particular group – so for instance you can create ”deeper” bars,

broader ribbons, or change the colors, alter the labels on the axes, choose a
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different perspective…. The chart functions range from relatively simple set-

tings, such as the length of the axes through the 3D rotation, to complex

mathematical calculations such as non-linear fits or filter functions.

The chart functions can be divided into three areas, which are discussed in the

corresponding sections of this manual:

• Axes – see Overview: Axes

• Graphs and Labels – see Overview: Graphs and Overview: Captions in

Charts

• Legends – see Overview: Legends

To arrive at the chart functions: place the mouse pointer directly onto an

element of the chart component you want to change (e.g. an axis) and with a

context click, open up the context menu for the group in question. A context click

– depending on the mouse settings in the operating system – is usually a click

with the right-hand mouse button. You can see some examples of this in the

Figure ”Context menus for chart groups...”. Then use the mouse to choose an
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item in the context menu so that you can change the chart group selected. After

any alteration the chart is recalculated.

Incidentally, you can also access the most important chart functions for each

group by means of a double-click on an element in the group. Alternatively, you

can select some of the general chart functions via the Chart menu.

Let us suppose for example that you want to change the initial and final values

of an axis. To do this, click the right-hand mouse button on the axis and select

Axis setup… . In the dialog that

opens up (see illustration) enter the

desired values for From: and To:.

Leave the dialog with OK, and the

changes you want will be carried out

in the chart.

You can also alter the type of chart

for graphs that have been changed in

this way by selecting another type
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from the Chart menu. During this process all the meaningful settings for the

new type will be retained.

As the initial decision for a particular type rules out the possibility of converting

the data into certain other types, these menu items are switched off. The

affected menu items are recognizably grayed out. These context-sensitive user

prompts are maintained throughout Xact. Functions that would not make sense

in a particular context cannot be selected. In the same way, a context menu only

contains those functions which serve a purpose for the object selected.

From chart to presentation – the graphics editor

If you want to make further changes to your graphics – with additional

lettering, gradations, clip-arts, logos, etc. – you can use the Graphics editor. In

the left-hand margin of a graphics window you will find the drawing tools you

need for the purpose. Using the context menus of the graphics elements you

have drawn, you can change features such as their appearance, position or other

properties. You will find an introduction to this in the section Drawing and

Illustrating. The section entitled The Text Object goes into special detail on how

to work with text. The graphics editor is a complete drawing program that you

can also use as a stand-alone program independently of any charts.

Graphical elements that have been added to charts can be changed in any way

you want as the chart functions do not affect them. You could also dissect and

alter charts down to the finest detail as these also consist of graphical elements

from the graphics editor. However, charts that have been ”dissected” in this way

can no longer be recalculated.

At a glance…

... here you can see all the steps in

a not entirely straightforward examp-

le - after all, you want to know what

Xact can do! In the next figure you can

see the Table editor window. The

descriptions of the lines have been en-

tered in column 0 under Legend – here they are the names of the months.

Columns 1 and 3 contain the figures that are to be represented, column 2 is not

to be shown in the chart.
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In the line Types, the data columns

are assigned to the axes of the chart.

Transaction 1 has been defined as L

Y1, which thus specifies that the data

in this column are assigned to a Left-hand Y-axis. Transaction 2 has been

defined as R Y2 and is thus allocated to a Right-hand Y-axis. The numbering

(Y1 and Y2) determines the sequence of the symbols in the chart. In this case

Transaction 1 is drawn first and then Transaction 2.

One method of defining the columns in this way is to click in the right and left

halves of a cell in the Types line. If a column is not explicitly defined, all the

data columns present will be numbered consecutively from left to right as L Y

columns.

In this example we shall plot num-

bers against categories, namely the

names of the months. As no column

is defined as X, the names of the

rows will be used for labeling the X-axis and we obtain an alphanumeric

X-axis.

In general, only selected areas of defined columns are shown. We could

now select a particular area of the table with the mouse. However, as we want

to show all the data in the defined columns, we do not need to do anything - Xact

automatically selects the whole table. For more information, please read The

Table Editor section.

In the Chart menu of the table under Bars…, the type Rows 3D is selected, thus

generating the ”raw chart” shown below. Many of the properties for this raw

chart can be specified in the File menu under Preferences. You can read up on

how to do this in the Help system under the heading Preferences!

Now we’re going to edit the

chart with the chart functions

mentioned previously. Here we

shall systematically list the

changes made - although in

practice, the changes made to a

chart are seldom planned…:

Context menus for the

graphs : Under Graph style...
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in the Transaction 1 graph we select the entry Ribbon 3D and thus swap the bar

graph for a ribbon graph. In Transaction 2 under Caption… we select the

position Bottom of chart and leave Insert row legend as the Formatting. Under

the entry Fill style… of the context menu we switch to Gradation/2 colors with

the Starting value of 53% gray and the End value 86% gray.

Context menu for the left-hand Y-axis: We open Axis setup… . On the page

Scaling/Axis scale, after To: we enter 35. On the page Labels/General for

Position at ticks we enter top, under Format… in the dialog Number for-

mat/Symbols after Behind: we enter %.

Context menu for the right-hand Y-axis: We open Axis setup… . On the

page Label Align: is set to align right. On the Axis title page ”in $” is added to

the text taken from the table.

Context menu for the X-axis: We open Axis setup… . On the Ticks page the

Grid lines are checked, on the Label page, the Show box is unchecked.

Context menu for the Legends : First the command entry Ungroup frame

group is executed. In the context menu we then select the Legend… entry. On

the General page Just text is checked as the legend type, under the Frame option

None is selected, under the Lettering options the Fill style… is set to Covering

and White.

The legends are then drag-

ged with the mouse to the

positions on the graphs

shown in the illustration.

In the Overview Charts:…

sections you will find out

more about the settings we

have listed here. And in the

Example sections you can

learn by doing.

Connections to the outside world

Suitable and complete import and export formats are important for profes-

sional publications. In the overview we have given you a list of the formats that

you can select for a document in the File menu under Import and Export.

Depending on the operating system you can of course also exchange graphics,

text and numerical values via Copy and Paste contents. If you publish in
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PostScript, we recommend the EPS format to ensure that graphics are exported

correctly. The windows version of Xact provides you with several bitmap for-

mats for import and export.

Exporting graphics with CMYK colors

Working with Xact Pro you can choose the colorspace CMYK. This is needed

for the professional printing process where color definitions must be kept.

Today you must export files created with CMYK as EPS or PS, as these are the

only widly used vector formats that can use CMYK.

Tables

Graphics

- L T Xa e
- DIF
- ASCII

- WMF
- GEM
- TIFF
- PCX, BMP
- OS/2 Metafile
- RTF
- Shapefiles (*.SHP),

only in XactPro

- Lotus
- Excel
- DIF, CSV
- ASCII...
- dBase

- WMF, GEM
- PostScript, EPS
- OS/2 Metafile
- Adobe Illustrator
- HPGL
- TIFF
- PCX, BMP

Import- and Export-filters
in Xact:
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Mouse and Keyboard Commands

These command summaries for the Table and Graphics windows will make

working with Xact easier for you. You will find them on your hard disk in the

Xact folder under GRAPHICS as files named GRFSHORT.XGF and TABS-

HORT.XGF. Print this file and keep the copy next to your keyboard!

Table windows

Selecting:Positioning:

Editing:

Return

F2 Change cell contents

Down one line

Return Line breakCtrl
(when changing cell contents)

Tab

Page Up

Page Down

Shift One column to the left

Tab One column to the right

Up one screen

Down one screen

Home

End

To first column

To last column

CtrlHome To first cell

Ctrl To last cellEnd

Deselect allEsc

CtrlHome Shift Extend selection to first line

Ctrl Shift Extend selection to last lineEnd

Shift Arrow Extend selection

Page Up Extend selection
by one screen upwards

Shift

Page Down Extend selection
by one screen downwards

Shift

Arrow Adjacent cell

Arrow Adjacent cell +continue editingCtrl

Arrow Adjacent cell + continue editingStrg

Alt Get special characters boxInsert
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Graphics windows

Shift

Ctrl

Arrow Move objects/points (slowly)

Space bar Reuse tool last selected

Move objects/points (quickly)

Select further objects

Ctrl Arrow Select visible objects

Select further visible objectsCtrl Arrow Shift

Esc Interrupts mouse operations
(e.g. moving, enlarging)

Deselects objects/points
Switches back to pointer mode

Arrow

Enlarging/reducing objects

Click on objects Moving objects

Esc

Button

Shift Enlarge proportionally with corner handles

Shift Copy object while moving it

Alt Move object horizontally only (OS/2 only)

Alt Shift Move objects vertically only (OS/2 only)

Enlarge in one direction with center handles

Z Magnifying glass (Zoom)

B Rectangle (Bar)

C Circle

V Vertical line

H Horizontal line

T Text

E Empty pipette

F Filled pipette

R Rotate

P Polygon

+ Enlarge image section

- Reduce image section

Explanation of the symbols:

Tool bar:

Selecting objects:

Moving objects:

Enlarging objects:
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Drag & Drop for Data and Graphics

If data or graphics already exist as files, they can be dragged from the work

surface using the mouse with the button depressed and then dropped onto an

Xact document.

In the above case, data files (*.CSV, *.TXT ...) can be dragged onto the top

right-hand corner of an Xact chart. The data will be used dependent on

where the mouse pointer is placed on the chart: here (top right) the data are

assigned to a right-hand Y-axis and an X-axis in the upper position. The

chart will thus have two Y and two X axes. With this type of ”drag & drop” the

position of the mouse determines how the new data are used. Depending on the

quadrant (and chart type) targeted the following allocations are made:

- left/right half of chart gives a left-hand or right-hand Y axis

- upper/lower half of chart gives an upper or lower X axis.

Data-file: Xact-Chart

+ =

Drag & Drop with data-files
(e.g. from Explorer):

Data-file:

+ =
Xact-table
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How a chart responds when a table is added is determined in the Add tables…

dialog. This specifies for example whether the existing column definition will be

”passed on” to the new table or whether a specific predefined definition pattern

is employed. The way in which the data are used can be adjusted in the context

menu of each chart under ’Links…’.

A similar thing happens when a data file is dragged onto an Xact table: here

the position of the cursor determines the position at which the new data are

added to the Xact table. The characteristics are specified in an analogous

manner to the above case in the dialog ’Add tables…’. If the cursor is in row 0 or

1 of a table, the new data will be examined for existing legends and then, if none

exist, imported from column 0 onwards.

If a graphics file, e.g. *.WMF or a symbol from an Xact symbol library is

dragged into a graphics window, its content will be displayed there. This

also applies to text files.

Drag & Drop of graphics files
(e.g. from Explorer):

Xact-graphics

+ =

Graphics file,
Xact-symbol

Xact-chart

+ =

Graphics file,
Xact-symbol
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If an graphics file is dragged onto an Xact chart, its content will be used in

different ways according to the position of the mouse pointer.

• If there is a marker directly below the mouse pointer, all markers in this

graph will be replaced by the symbol.

• If there is a bar of a bar chart directly below the mouse pointer, all bars in

this graph will be replaced by the symbol.

• If there is a chart frame directly below the mouse pointer, the contents of this

frame will be replaced by the symbol.

When these replacements are made, the size of the symbol is adapted to match

the situation; further changes can then be made in the Context menu of the

relevant graph.

One example of the use of this technique can be found in this manual under

Examples: A Simple Object Chart.
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Digitizing Drawings and Pictures

Often data only exist as a chart, but you want to have the underlying figures in

table form as simply and quickly as possible.

The digitizing function is intended for this application. It can be used to digitize

charts or maps which exist as raster or vector images.

First the image is loaded into a graphics window (Open… in

the File menu). Then in the tool bar of the graphics window (at

the left-hand edge of the frame) you select the arrow symbol. If

you keep the mouse button pressed down, a context menu will

open, and selecting the last symbol on the right will activate

the Digitization. The mouse pointer changes into a hollow

rectangle with cross-hairs.

For digitization you first have to define a system of coordinates. To do this,

you set

(1) a horizontal axis (X) by clicking the mouse once to mark the starting point

and once again for the end point

(2) do the same for a vertical axis (Y).

Shift these points as accurately as possible to the desired positions!

After you have set the total of four end points for the axes, open the context

menu of one point or press the Enter key. Select Define…, and the Scaling dialog

will appear. Here you can set the Starting and Finishing points for the Y and X

axes and the type of scaling.

Leave the dialog by pressing OK and

a new table is opened which already

contains the column headings X and

Y. Afterwards, all the points that are

set by mouse click are converted to

the preset axis scaling and are ente-

red into this table according to the

order in which they are clicked.
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If you want to digitize several curves at the same time, open New parameter

in the context menu. Afterwards two new X and Y columns will be entered in the

table and points sets after this will be included in these columns. If you want to

digitize more points for the first curve, first click on an existing point in the first

curve and then continue in the usual way.

While digitizing, you can alter the position of the points that have already

been set. For this you first need to select them with the mouse or with the

combination Ctrl + arrow key. You can then shift these points with the mouse

or with the arrow keys.

• The magnifying glass can also be used while you are digitizing and this enab-

les you to work accurately at pixel level.

• You end the digitizing function by clicking on End in the context menu, by

pressing the ESC button or by selecting a new tool (except the magnifying

glass) from the tool bar.

The data table you have created can be used for creating charts, for expor-

ting data or for calculations, to name but a few examples.
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The Table Window

Xact displays data in rows and columns in table windows. You can import

and enter data into these data windows and then edit and use them for

calculations. All the charts in Xact are generated on the basis of the data in the

table. For this you need to select the data that is to be presented: as a rule, each

column in the editor corresponds to a series of data (curve, ribbon, bar) in the

final chart.

First let us take a brief look at an Xact table: the above illustration shows you

the structure of a table window. Monthly results measured over two years have

been selected as specimen data. There is a series of data for each year, which is

entered in a separate column – therefore the years have been selected as the

column legends. As there is a reading for each month, we have chosen the

names of the months for the rows legend.

Xact tables as files

Xact tables on the hard disk can be recognized by the ending XTF in the

filename. In addition to the actual data, they also contain information on the

column definition and data types as well as the formulas, titles and sub-hea-

dings that you have entered yourself.

Creating tables/Entering new data

If you want to enter your data directly into an Xact table, you first have to create

a new table. To do this, select the command New… in the File menu.
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The keyboard commands in the table editor correspond to those commonly used

for spreadsheets. Newly entered characters will overwrite the content of the

currently selected cell. In order to change the content of a cell, but not comple-

tely overwrite it, double-click the left-hand mouse button on the position that

you want to change. You will find an introduction to working with the table

editor, when you press the help key in a table window – see the section Mouse

and Keyboard Commands.

If you want to enter a line break in a cell, press the key combination <ALT>

<return>. Please note that you can use time and date formats in Xact tables –

you will find more detail on this in the help system.

• You can type any text you like into the table, so – even apart from the le-

gends – your input is not restricted to numbers. This has a number of im-

portant consequences: for instance, when creating table charts, you are not

only able to create tables of values, you can choose any type you like. What is

more, you can add units when typing in figures, for example ”-1.3 cm”. When

charts are created, the unit is ignored, whereas the complete number with

unit appears in a table chart.

• Internally, all entries are saved as texts. If, for example, you use the functi-

on Shorten numbers and thus remove figures after the decimal point, these fi-

gures really have been removed – they will no longer be used in calculations!

Entering the legend/Automatic legend

The legend texts are in the first row and column. They are taken from there for

use in the charts, e.g. to label the axes. If you decide not to type in a legend, Xact

will generate it automatically. The 5th column for example would have the text

”Column 5”. If required, you can switch off the automatic legend function in the

File menu under Preferences/Table.

Opening table/Loading existing data

How you start your work in the table editor depends on the form your data take.

For instance, you can copy data from a spreadsheet and then paste them into

an Xact table. The data are then inserted at the cursor position. If the data

already exist as a file, you can load the file directly with Open… in the File

menu. Apart from tables in Xact format, several commonly used file formats are

also available:
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• ASCII or text files

• DIF (Data Interchange Format)

• CSV (with comma or semicolon as separator)

• WKS, WK1, WK3 (from Lotus 1-2-3 ® or Lotus Symphony ® )

• XLS (from Microsoft Excel ® ‘97 on )

• DBF (from DBase ® III, III+, IV)

You can generate text files in almost any program. This option is usually offered

in the form of an export format or print to file. Xact is very flexible in interpre-

ting text files and so you can load almost all data perfectly.

Importing data

In already opened table windows

you can import data by using drag &

drop (see previous section), the com-

mand LINK (see next section) or the

command Import… (in the File

menu). When you import files, the

data you are loading is inserted at

the cursor position in the table,

without a new table being opened. In

this way the import function can be

used to compile a table from several

sets of data. Always place the cursor at the desired position and select Import…

in the File menu. The imported data will be placed in the table, downwards and

to the right of the cursor. No new columns will be added during this step;

instead the existing columns will either be filled or overwritten.

Several options let you control the way data is imported. Please read the

online help for further information! A special option might be interesting for

those working with large amounts of data:

Data reduction during import

Measuring devices often generate enormous quantities of data in a very

short time. A graphic presentation generally requires no more than a few

hundred values per data series. Therefore if required, Xact can reduce the data
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directly while loading them. If you activate the Data reduction switch on import

and select, say, 10 as the Interval size, the program will only load every tenth

value into the table.

• You should only use the Data reduction option when you have a large number

of approximately constant data; otherwise there will be a real loss of informa-

tion. If the data are not approximately constant, we recommend that you eit-

her present all the data or restrict yourself to the interesting regions of data

during the analysis.

Exporting and export formats

If you want to continue working in

other programs with tables that have

been loaded or entered in Xact, the

export function gives you a choice of

formats for the output. When expor-

ting tables, we recommend that you

use the very well-defined DIF format.

Where possible, do not opt for diffe-

rent formats unless the program in question does not understand DIF. Xact

tables – or parts thereof – can be saved in three external formats:

• Text: the standard format that almost always produces results.

• CSV: text format with a separator that varies according to the country set-

tings on the operating system in use.

• DIF: the most reliable format. Use DIF whenever possible.

Sometimes you might only want to export certain section of the table. To do this,

simply select the columns and rows that you want. Call up Export in the File

menu and activate the option Export selected areas only.

Export as LATEX table

Xact offers TEX users the option of output as a fully-formatted LATEX table

with a large number of possible configurations. A large range of formatting

options, some of which would require a great deal of work if carried out manual-

ly, are available at the touch of a button. Once generated, the file can be copied

or integrated into your LATEX document using an Include command.
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Using Table Windows

The table windows can be used for editing and reading in data as well as for

manipulating and automatically generating data. In the table window you can

determine how the data are used in the charts by means of the definition of

columns and selection of ranges.

Defining column types

You will often want to use all the columns of a table in the chart, and

represent each column as a separate graph. For this purpose the columns in the

table are defined as Y columns and are numbered from left to right. Xact selects

this standard definition automatically if you have not defined any column types

yourself. Values from Y columns are plotted on the Y axis in the chart: the

greater the value, the higher the bar or line will be (depending on the type of

chart).

As well as Y columns, Xact also has the following column types: X and Z

columns (for 2D and 3D plots) and four types of deviations (for error bars,

measuring tolerances, etc.). For Y columns there are options for deviations in

both directions, only positive or only negative deviations(Dev, Dev+, Dev-) and

for X columns a type for both directions, DevX. The column head displays the

type and consecutive number of the co-

lumn so that you do not lose track of

where you are.

Defining columns – by mouse

click

Every column has a column head

consisting of two lines. The column

heads are numbered consecutively in

the table screen. If you click the type

line of a column head with the left-hand

mouse button, the column below will be allocated a new Column type. If the

column has not yet been allocated a type, it will be allocated the first possibility,

i.e. ”Y”. Clicking again will take you to the next possible type.
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Let us assume you have created a new table and have clicked the Type field

in column 1. The description ”Y1” will then appear in the type field. The letter

”Y” indicates that the values in this column will be plotted on the Y axis of the

graph.

When you click on further columns, they will first be defined as Y columns and

numbered consecutively according to the Sequence of definition. The index

number ”1” indicates that this column will be transferred to the Y axis first.

This is particularly important for three-dimensional charts. The series of data

are plotted back to front from high to small indices. ”Y1” therefore always

denotes the series of data represented at the very front. Hence the order in

which you select the columns will determine the sequence of characters in

charts!

• An X axis is always needed, too, in order to display the data. There is no

constant X axis in the standard definition. The values (e.g. bars) are simply

plotted from left to right with the same intervals. Xact then uses the consecu-

tive row numbers as the X axis and describes these with the row legend. This

type of X axis is known as alphanumeric. If you want to plot data against a

numeric X axis, you must define at least one column as X!

In the column head you can also determine whether the values in the column

are to be assigned to the left or right axis (or top or bottom). Line charts, in

particular, often use a display with two different Y axes. In the column head,

the letter ”L” stands for the left axis and ”R” for the right. For X axes, ”B” stands

for a bottom axis and ”T” for a top axis. By clicking on the letters, you can switch

between left and right.
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Defining columns – by context menu

Another way of changing the co-

lumn type and axis allocation is to use

the context menu for the column. Se-

lect the desired columns and then

press the right-hand mouse button

with the pointer over one of the co-

lumn heads. In the context menu select a new column type or a different axis

definition. Your choice then applies to all the columns selected.

Defining a number of columns - by dialog

If you use big tables with a large number of columns, you can have all the

definitions performed automatically by selecting the entry Column types… in

the Table menu. You can also select from a list of preset definitions in the dialog

that appears. For example, if you select ”X,Y”, clicking OK in the box will define

all the columns in the table alternately as X and Y types. Moreover, you can

design your own definition settings in this dialog and insert these in the list.

You will find more information in the Online Help under the heading ”Dialog

‘Define column types’”

The different column types

The first mouse-click in the Types field of the column head always produces

Y columns. Further clicks will change the column type consecutively and the

following types are obtained in sequence: Xn, Zn, Dev n, Dev+ n, Dev- n and

DevX n.

Here, ”n” always stands for the index of the column in question. In a table

consisting only of Y columns the row legend will be used as the X column in

charts. The data from this column will not be plotted on a numerical X axis until

one column has been defined as X!

A simple way of defining column types for several columns is to use the Column

types… entry in the Table menu. The definitions entered there are stored and

can be called up time and again.
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XY plots

If you have defined at least one column in the table as the X column, you will

obtain XY plots with a numerical X axis for a large number of chart types.

Instead of the row legend, the X axis will then consist of a scale for the range of

values on the X column. In some chart types (e.g. most types of bar charts) a

numerical X axis cannot be used.

The series of data are sorted according to the X values as the default and so the

curves generated always run from left to right in the XY system of coordinates.

To represent loci you can switch off the function that sorts the X values when

selecting the chart.

XYZ plots

The same applies for the Z axis. If your data are in the form of 3D coordina-

tes, you can have them displayed as portfolios, XYZ plots, 3D surfaces or

contour plots, for example.

Deviations

If Dev-n appears in the head of a column, the values of this column will be

assigned to the Y column with the same index as error bars. If a column DevXn

appears in the head of a column, the values of this column will be assigned to

the Y column with the same index as error bars parallel to the X axis. Options

for displaying deviations include in line charts, two-dimensional bars, 3D lines,

XYZ plots and profile charts.

You can allocate a Y column to any other column of the table as a deviation

column; depending on the type of deviation your data contain, in both directions

or as positive or negative deviations. By marking the columns as Dev- and Dev+,

you can display positive and negative deviations independently of each other in

Xact.

Normally you will import the data for presenting deviation or error bars at the

same time as the table and then designate these columns in Xact accordingly.

Calculation of the standard deviation is one of the statistics and formula

functions in the table editor.
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Selection and definition

In the meantime you will have noticed that there are some differences

between working with a spreadsheet and the Xact table editor. In fact the large

number of different column types means that this could not be done any other

way. For you as the user, it is essential that you understand how defining

column types and selection are connected.

The definition of a column (the type) determines how the data are plotted

in the chart. If a column has no type, its data will not be used. Selection – when

available – puts further restrictions on the area to be displayed.

• A cell within a table will not be used in a chart unless it is located within the

selection and its column has a type. If no selection has been made when a

chart type is called up, Xact automatically selects the whole table. If no co-

lumn types have been defined, all the selected columns will be designated

type ”Y” columns.

Selecting and deselecting all columns

Calling up Select all in the Edit menu selects all the columns. Deselect all

has the opposite function.

Activating and deactivating rows

Selected parts of rows can

be activated or deactivated in

the context menu (mouse click

with the right mouse button at

the head of the row). Deactiva-

ted rows are shown with a red

line through them in the table,

and are not used. Deactivating

rows can be especially useful if

a large table contains several

invalid ranges of measure-

ments that you do not want to

depict.
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Selecting ranges

Apart from individual rows and columns you can also select entire ranges.

To do this, click the mouse key while it is in the cell that is to mark the start of

the range and, keeping the mouse key depressed, mark the range by dragging

the mouse. The simplest way to select ranges of columns and rows is to click on

a column or row number and then drag the mouse in the desired direction while

keeping the button pressed. A click with the Shift key pressed down does not

begin a new selection but extends the existing one.

Selecting date types

Apart from text and numeri-

cal values Xact can also

process date formats. Select

the Date format entry in the

columns context menu (click

with right-hand mouse but-

ton on the head of the co-

lumn) to either choose one of

the available date formats or

define one to meet your own

needs.

• Under the heading Other… you can define any date and time formats you re-

quire in the Define data format dialog. Click on Help in this window to find a

complete list of the abbreviations for numbers of days, names of months and

the like.

Swapping rows/columns

Depending on the application from which you have imported the data, you

may find that the table has not been set up in columns but in rows. In such

cases, as Xact works on the basis of columns, you will have to exchange the rows

and columns. To do this, select Swap lines/columns in the Table menu.
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• This swapping action enables Xact’s column-based functions to be used on

rows too, by calling up Swap lines/columns before and after the function. For

instance, you can use the function Create columns, which is explained later in

this section, to generate a new column legend that will in fact be located in

row 0.

• When rows and columns are swapped, the column and row selection are re-

tained together with any formulas that have been entered. Therefore the co-

lumn formulas will not become row formulas.

Shortening numbers

The function Shorten numbers… in the Table

menu enables you to adjust the number of figu-

res after the decimal point to which numbers are

rounded off or truncated for a selected range. If

required, values with fewer figures after the de-

cimal will be filled up with zeroes. The Shorten

numbers… function only works on the selected

ranges in the table. Areas not selected will not be changed.

• In some cases – especially when automatically recorded data from measuring

instruments are concerned – the data series will have decimal places that lie

beyond the measuring accuracy or are not needed in the graphic presentati-

on. Particularly when tables are being printed, a high number of decimal pla-

ces can result in loss of clarity and very broad printouts.

Entering titles

In addition to the data, you can also specify a title or sub-heading for the

chart in the table editor. To do this, select the command Title… in the Table

menu.

The dialog shown then

allows you to enter the

first and second titles –

they are positioned abo-

ve the figure – as well as

a sub-heading for copy-
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rights, details of the data source, etc. below the figure. Details regarding the

source is one example where it is especially practical to have the information

permanently linked with the table. The next time you load the data set, you will

again have all these details at your disposal.

Under Preferences/Charts in the File menu you can specify the standard font

for the titles and sub-headings as well as the alignment (left, centered, right).

You can also preselect title texts – so that for example the date and time are

entered as sub-headings in all charts.

Create column contents…

This item from the Table menu enables

columns to be generated automatically.

Apart from allowing you to create a

month legend quickly, this function

also generates a series of numbers with

any start and end value in the column

where the cursor was placed. The step size, by which the values increase from

row to row, and the number of decimal places can be selected as required.

If the end value (dependent upon the start value and step size) is not reached

with the available number of rows, the table is extended automatically to

accommodate the number of rows needed.

Sorting by row…

Select Sort… in the Table menu and en-

ter a column number which you want to

use as the basis for sorting the rows. You

can then sort the rows in ascending or

descending order according to the values

in this column, and also alphabetically

for text. The sorting process always in-

cludes all the columns (not just those selected) so that the allocation of legends

to the data is not lost.
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Statistical values

In the Table menu the item Stati-

stics... allows you to generate a table

with the statistical parameters for the

section of the table you have selected.

These range from the mean via confi-

dence intervals to the geometric mean –

you can find a list in the Online Help.

Statistical tests

Under Tests… in the Table menu

you will find a dialog that enables you to

perform some parametric tests for de-

pendent and independent samples. The-

se tests for differences between means

and variances. The results appear in a

graphics window.

Linking several tables

Sometimes it is useful to be able to

link several tables with one another.

Work groups that want to compile their

results are one such example. Of course

the values from the separate tables can also be copied by hand, but creating

links can often have advantages, particularly if individual values frequently

change.

Links between tables in Xact are created using formulas with the command

LINK. LINK reads values from any required column of another table file, which

may for example also be an ASCII file. For more information, read the following

section called Calculating in the Table and the section on Reusing & Automat-

ing Documents.
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Calculating in the Table

The column-based method of calculating in Xact is particularly useful for

computing entire series of measurements – for example, if you want to subtract

two series of data and then multiply them by a factor. For each column you can

define a formula, which can then be called up at any time when the values

change.

By and large the formulas in Xact are used as in a spreadsheet. However, Xact

calculates on the basis of columns, whereas spreadsheets can contain a different

formula for each individual cell.

Entering formulas

If you want to use formulas in a table, you should first switch on the

Formula line (Show formula in the Table menu).

Then click with the left-hand mouse button on the formula field in the column

where the result of the calculation is to be written. In the formula dialog that

now appears you can enter a new formula or alter an existing one.
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The usual mathematical rules apply when entering the formula. Contrary to

mathematical shorthand, the multiplication sign has to be entered. Conse-

quently, the expression 3ab would be typed in as 3*a*b. Spaces between expres-

sions are not necessary but can be entered for clarity. You can also enter

brackets as required. You refer to the values of existing columns by their

column numbers, e.g. ”S1” for the

first column.

After From row: and Till row: you

can specify the range of the co-

lumn in which the results are

shown. The field LINK(…,1) is for

quickly selecting a file that is to be

linked (see Linking function la-

ter on in this section).

• If a 0 has been entered after Till row: (the default when the dialog is called

up), the results are always output from the initial row of the table to its end!

In the Decimal places box of the input dialog, you indicate the number of

decimal places to be used for the output of the results from the calculation.

• Only the decimal places that are actually visible in a cell are used for the

calculation and in the output!

Leaving the dialog with OK means that only the altered formula will be saved.

If you leave with Calculate, Xact saves and calculates the formula.

Dealing with errors

Errors in the formula, e.g. incorrectly placed brackets or incorrect notation, are

indicated by Xact before the calculation is performed. The position in the

formula is shown where the error or the ambiguity was found. Errors at

computation time (e.g. logarithm of a number <= 0 or root of a negative number)

are reported by Xact and the calculation is aborted.

Functions

• SIN, COS, TAN, ASIN, ACOS, ATAN, SINH, COSH, ASINH, ACOSH,

TANH, ATANH
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The trigonometric functions of Xact work in radian measure, i.e. SIN, COS and

TAN are given values in radians, whereas ASIN, ACOS and ATAN deliver such

values. An ’H’ at the end of the name of a function indicates that this is a

hyperbolic function. If you want to work in degree measure, you can use DEG

and RAD for conversion.

• DEG, RAD

The function DEG converts a value from radian to degree measure, RAD has the

opposite effect.

Example: C1 = SIN(RAD(90))

• SQRT takes the square root. The root of negative numbers is not defined.

• LN, LOG

LN yields the natural logarithm, i.e. to the base ”e”. LOG is the decimal

logarithm. Logarithms of numbers <= 0 are not defined.

• EXP Tip: in Xact the constant ”e” must not be used as this letter is reserved

for the parameters in the non-linear fits. Instead, use EXP(1).

• FAC yields the factorial of a number. It is calculated from 1*2*3*…* number.

• ABS yields the absolute value of a number.

• CUM(Column number)

Cumulates the values of the column “Column number”. Example: C2=CUM(C1)

Taking C1=1,2,3 gives C2=1,3,6

• DIF(Column number) is the reverse function of CUM. Example: C2=DIF(C1)

Taking C1=1,2,3 gives C2=1,-1,-4

• dateToNumber() creates numbers from date or time strings, for more infor-

mation see the Online Help.

• numberToDate() calculates date or time from a number, for more informa-

tion see the Online Help.

• random() creates random values in the range > 0 and < 1, for more informa-

tion see the Online Help.
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• randomGauss() creates Gauss distributed random numbers with mean = 0

and standard deviation = 1, for more information see the Online Help.

Linking function

• LINK ()

The function LINK enables values from other files to be used. These can be read

into the selected Xact table. The Import dialog can automatically create LINK()

functions in formula fields.

LINK () can have up to three parameters: the first parameter is always the file

name (incl. path), the last one the column number of the file to be imported

(column numbers always start with 0).

If the file name is of type XLS the second parameter can be the name of a

worksheet in this file. If no second parameter is used, Xact imports data from

the first found worksheet.

Examples:

- LINK(“Test.XLS”, “Table1", 0) imports from the file ”Test.XLS" column “0"

from worksheet ”Table1".

- LINK(“Test.XLS”, “Table1", 0) imports from the file ”Test.XLS" column “0"

from the first worksheet in this file.

If the file type is not XLS the second parameter CAN contain a string to be used

as column separator. (Xact always tries to convert imported numerical data to

the Xact number format: no thousand separator, decimal sign is “.”. The nume-

rical data will be parsed for the characters given in Menu “File/Preferen-

ces/Charts/Number format”.) The second parameter is used to determine the

column separator and must be a not-number. Typically it could be “;” or “:”,

special cases (see dialog ‘Import’) are:

- Tab character: type as “TAB”

- ASCII-Table: type as “ASC”

- Unknown: type as “ALL”
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How it works in the not-XLS case: as said above the string is made of one

character or - in the special cases - three characters and is referred to as

“Separator Symbol”.

Let us look for the behaviour using ONE Separator Symbol. After the occurence

of the Separator Symbol in the file, Xact starts a new cell:

-LINK(“Test.TXT”, “,”, 1) imports from the file “Test.TXT” column 1. A line from

Test.TXT may look like this: “Cell 0,Cell 1,Cell 2". The cell of the Xact table

window shows ”Cell 1". After the first “,” in each line of the file a new cell starts

in the Xact table window until the next “,” appears (or the line ends). That

means also: if in a line of the file two Separator Symbol follow each other

directly, it creates a empty cell. So “Cell 0,,Cell 2" creates a empty cell.

If TWO identical Separator Symbols are used as separator string, a cell ends

with the first Separator Symbol. The next cell then begins with the first

character in the line of the file being not a Separator Symbol:

-LINK(“Test.TXT”, “ ”, 3) contains as Separator Symbols two spaces and im-

ports column 3 of Test.TXT: a line may be: “Cell0 Cell1 Cell2 Cell3", the

result is ”Cell2". In the Xact Table window “Cell2" appears. (Column 0 would

contain ”Cell0", column 1 would contain “Cell1", all following spaces are skipped

until a non-space occurs, the ”C" from “Cell2". In the Xact table window all

following characters are written to this cell until the Separator Symbol (space)

is found. Thus any number of Separator Symbols following eachother separate

one column from the next. That means also: No empty cells are written to the

Xact table window. In case of tab stop the separator string would be ”TABTAB".

With CSV files strings between “ are always completly written into one Xact

cell, even if they contain Separator Symbols. Example:

-LINK(“Test.CSV”, “,”, 1) imports from the file “Test.CSV” column 1. A line in

Test.CSV may be: <Cell 0,"A cell with a Separator Symbol,",Cell 2> The Xact

cell would be “A cell with a Separator Symbol,”: The “,” after “...Symbol” is NOT

used as a separator.

If ALL is used as a Separator Symbol, the following characters are used as

column separators:

all unprintable characters up to and including the space character and the

characters !#$%&()*,;<=>
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Expressed as ASCII-codes: 0-33, 35-38, 40-42, 44, 59-62

If only two parameters are used in LINK(), the first one is the filename, the

second the column number to be imported. Example:

-S1 = LINK(“MYTAB.XTF”,2): if the directory is not entered, Xact assumes that

the table is present in the same directory as the one that is being edited.

The linked file does not necessarily have to be an Xact table. However, Xact

should be able to import the file format. For reasons of speed, it is advisable to

us only one link function in a formula and perform further calculations in

another column (see below).

One exception is when this function is the only entry in the formula. In this

special case:

• Inserting data is much faster.

• The legend is used as column legend.

• The data are always read starting from row 1 in the source file.

• All rows from the source file are always read.

• The filename and – if present – the column legend of the source file are im-

ported. This procedure is especially helpful for maintaining clarity in tables

and charts where the various linked tables have identical column legends.

The following example illustrates this:

-C3=LINK(”\DATA\MEASDATA.TXT”, 3) copies the fourth column from the

file MEASDATA.TXT into C3. Suppose the original legend of the fourth column

of MEASDATA.TXT were ”Y”. Hence the legend of column C3 will become:

”MEASDATA

Y”

Statistical functions

Statistical functions always use ranges of a table. For instance, the means of all

the selected lines of columns 1 to 8 can be calculated. A range is designated with

two columns separated by a colon.

Example: C9 = MEAN(C1:C8)
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• SUM calculates the sum of all values within a range.

• MEAN calculates the arithmetic mean of all values within a range.·

• STABW calculates the standard deviation within a range.·

• STERR calculates standard errors for a range.·

• MIN, MAX yield the smallest and largest value within a range.

Constants·

• PI is a dummy variable for the mathematical constant pi.·

• LINE changes from line to line. In each row it has the value of the row num-

ber. When the formula is calculated for the first row, LINE therefore has the

value of 1, in the second row 2, and so on.

There are many conceivable applications for this constant; however, if you want

to create columns with a linear increase in the values, you will find the function

Create columns in the Table menu is more straightforward to use.

Sample formulas

C1 = 1.2

C2 = C1 + 5.3

C2 = 1.14 * C1

C3 = (C1 + C2)^2

C4 = SIN(RAD(C3)) + LOG(C2) + 2*C1

C5 = SQRT(((C1 + C2) * (C3 + C4))^3)

Recalculating formulas

The formulas that have been entered are stored as in a spreadsheet and can be

called up time and again. If you want to have the table recalculated, for example

because the values have changed, simply call up the item Recalculate now in the

Table menu.
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During recalculation all the columns are calculated in order of the dependent

functions and the links are updated. Therefore if the formula in column 2 refers

to column 4, column 4 will be calculated first and then afterwards column 2,

although Xact works from left to right.

Circular references

If the user has accidentally created a so-called circular reference, Xact will give

a warning message. A simple example of a circular reference would be the

following formula system:

C1 = 2 * C3

C2 = 3 * C1

C3 = 4 * C2

Without the check, Xact would enter an endless loop because the formulas are

mutually dependent.
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Reusing & Automating Documents

Xact offers several ways of simplifying recurring operations, which can also be

combined:

• Stylesheets let you create your own chart types

• Links let you connect tables and charts with one another

• Batch files, macros (OS/2 only) or the programming interface (OS/2 or

Windows > NT) let you automate complex operations.

To choose the best way you will need more information how Xact handles

documents. As you already know Xact Graphics windows contain objects. These

can be graphic or chart objects (they are in the end made of graphic objects, too).

To reuse graphic objects, simply copy them to a new graphics window. While

graphic objects are created (or imported) by you, chart objects are created by

Xact.

Reusing Chart Objects

Chart objects are always made of data from a table window, so chart objects

“know” from which table they are made from. In the diagram you can see how

each chart of a graphics document is linked to different ranges in a table.

As a general rule, when charts are created they are always linked with the

range of the table from which they have been generated, provided the table has

already been saved. As a result, each chart ”knows” from which table and

which selection range it comes from. When a recalculation of a chart is

performed (with a click on Recalculate now in the Chart menu or on printing or

Xact-table Xact-charts

link

link
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opening a file), the chart then rereads ”its” data range before displaying it.

During this process, tables that have not been opened on the screen are read. In

the File menu under Preferences/Charts you can specify in On recalculation…

how charts should generally react when is selected. You will find more on this

dialog later in this chapter.

If you are using several charts in a

graphics document, then each chart

in the document is linked with the

underlying table range. Here the

table areas may come from one or

several tabular documents.

As a result, one table can be linked

with several graphics documents.

With so many possibilities available, it is important to maintain an overview.

Xact offers you summarized infos on the whole document and more detailed

infos on each chart:

• For the entire Graphics document, you’ll find a list of charts and their links

to tables in the File menu under Document info... In this dialog click on Lin-

ked tables... to get a list of all charts and their linked tables.

• For a single chart you will find all the necessary information and settings un-

der Links…in the context menu of each chart. We will give more details in

Managing links later in this chapter.

As shown chart objects in Xact are always linked to tables that provide the chart

with its data. These links can be changed to reuse the chart. To do this you link

a new table with the new data to the existing chart. The results:

• the data of the new table is shown in the chart

• the layout of the chart remains as before

Reusing charts

There are two ways to reuse a chart:

Xact-tables

Xact-charts

links

links
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• if you want to reuse one single chart with one single table you can use the

stylesheet method. First create a stylesheet by saving the graphics window

“Save as stylesheet” (menu File).

• in any other case copy the chart(s) to a new graphics window and change their

links by clicking on the entry “Links...” in the context menu of each chart.

Making your own chart types – Stylesheets

Stylesheets are used in all automation methods and help to simplify the creati-

on of similar charts considerably. Stylesheets are graphics documents created

with Xact, that contain one rescalable chart and any number of graphic objects

such as texts and drawings. With stylesheets, you can make your own chart

types and then use these instead of those that are permanently installed in

Xact. You will find the menu item for calling up a stylesheet in the Chart menu

under Use stylesheet…

Advantages of stylesheets

If you want to use a single chart with different data at a later stage, you should

save it as a stylesheet. In this way you will avoid having to repeat the work; you

obtain your individual chart at the touch of a button.

• The chart contained in the stylesheet reacts according to the settings. For ex-

ample, if you have switched off the axis automation, rescaling will no longer

occur automatically.

Creating stylesheets

A stylesheet is created by storing a graphics document with an active chart with

Save as stylesheet… in the File menu.

Using stylesheets

Define and select the columns you

want in the table window and choose

the item Use stylesheet… in the Chart

menu. The Select Stylesheet dialog

that opens shows a miniature view of

the stylesheets. This saves you compu-

Overview: Reusing & Automating Documents Page 65



ting time if you are still unsure of which

stylesheet is the most appropriate (or

simply cannot remember under which

filename you saved the stylesheet that

you are looking for).

After you have selected a stylesheet, the

Use stylesheet dialog will appear. Here

you can specify for example whether and, if so, which captions are to be taken

over from the current table, and whether the axes need to be rescaled. In the

field next to Document: you decide which of the opened graphics windows is to

be used for drawing the stylesheet. In this way you can create a document that

contains various stylesheets together with standard charts.

Making your own chart types - Changing Links

As said above, tables and charts are linked with one another. Links are an

efficient tool for connecting several document with one another and thus form

the basis for reusing complex tabular and graphics documents. Changing the

link of a chart means linking it with a new table, filled with the data you want

to show with this chart. Of course the organisation of data in the new table must

fit to the possibilities of the existing chart.

Links - Usage and Managing

The context menu of eve-

ry chart has a Links… en-

try which takes you to the

dialog of the same name.

This enables you to view

and change the existing

links from this chart to its

tables within a dialog.

In the adjacent dialog you

can see a List of all tables

used in the chart and

their column definitions.
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Selecting (mouse click) a row in this list enables you to perform a number of

operations with the selected table: clicking on Current Table, Open loads the

table, Change replaces it with another table or Remove separates it from the

chart. If a table is removed from the chart, the data are retained in the chart -

but now there is no longer any link with the table. You can Delete a table if

several tables are linked to one chart. The table is then deleted from the chart.

• If there is only one table used in chart and you will replace it by a new table,

simply click on Change.

You can also change the column definitions of the rows selected in the list. You

will find all the switches needed to do this under Change of Definition on the

right-hand side of the dialog. If you want to remove a graph from the chart but

retain its definition in the table, check the Invisible box.

The remaining settings in the dialog determine how the chart behaves when

being recalculated.

If a chart has been newly created, these settings will be adopted from the

current preferences on the Charts page, under On recalculation... . Here you can

preset the link behaviour of all charts created later:

• Change scale automatically for: If this box is checked, the starting and finis-

hing values of the axis affected will be reset each time recalculation is perfor-

med, depending on the figures in the table(s).

• Use rows/columns: Here you specify whether ba-

sically all rows are to be used or just a fixed row

range from the linked table. Use column definiti-

ons of tables means that the currently defined

columns of the linked table(s) are used. If this

switch is active, the column legends have no ef-

fect, as the legends are always updated in this

case.

• To use from table: the following characteristics can be adopted, and they then

overwrite the characteristics already present in the chart: Column definiti-

ons, Column legends and the Title of the table concerned.
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Linking a table with other tables

Every column within a table can be linked with a column in another table using

the command LINK.

This linking of tables with each other not only applies to Xact tables but to all

the tables that can be imported by Xact. Hence an Xact table (the target table)

can be linked with any num-

ber of ASCII tables that con-

tain data from measuring

equipment or the various

members of a working group.

The target table can in turn

be linked to one or more Xact

charts. You can read up on

details of the LINK function

in the section entitled Calcu-

lating in the Table or in the

Online Help (under LINK).

Graphics file lists for exporting and printing

If you want to print or export a large number of files, the File list dialog provides

a convenient way of selecting and grouping them, before you process them as a

batch.

If you just want to print or export

files from one common directory, it

is easier to open a Graphics Explo-

rer window in this directory, select

the wanted files and give the wan-

ted command in the context menu

of the Grapics Explorer.

You access the dialog via the opti-

ons Print... and Export... in the File

menu. In both cases you can choose

the Print or Export filelist only...

Xact-table
link 1and 2

Xact-table

ASCII-
table

link 3 and 4
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button. You can compile the files you want here from any directories by selec-

ting files under Source and adding these to the Selection. The two preview

images enable you to retain an overview of what is happening.

• In the XactPro version you can also save the selection you have compiled as a

list or add it to an existing list.

More automation through programming

Frequently recurring tasks can be efficiently simplified using links; however,

working operations can only be completely automated (i.e. without user inter-

vention) with the Programmable Interface.

Xact offers several interfaces for various applications, and for those of you with

programming knowledge, so that you can automate complex sequences of opera-

tions.

• Programming Interface (currently REXX and ’C’ for OS/2 and MS Windows

>= NT)

• Batch files (for MS Windows only)

• REXX macros (for OS/2 only)

The programming interface (Windows >= NT and OS/2)

For optimum integration of Xact into your applications or solutions, a program-

ming interface is provided for REXX and ’C’. Please read the separate documen-

tation on this in the Xact Programming Toolkit. The programming toolkit and

the accompanying documentation were written on to your hard disk under the

name XACTRPC when Xact was installed.

Batch files (Windows version only)

Batch files allow you to completely automate many tasks, e.g. the regular

processing of measurement data, or the printing and export of all the files

within a directory. For details, see “Batch processing” in the Online Help.

Batch processing is based on those Xact documents that are processed with the

batch commands.
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Batch files are written in a similar style to a C or Pascal program text: they

consist of a sequence of single function calls separated from each other by a

semicolon. The parameters of the functions are placed in round brackets after

the function name.

You can document your batch files by inserting comments in the text at any

position you like. A comment is introduced with a double slash (“//”) – the

remainder of the line is ignored by the program.

Creating and executing batch files

Batch files are normal text files (ASCII) that can be created with any conventio-

nal text editor. The batch files are given the ending XBT and are passed to Xact

when the program is started.

There are two ways of starting Xact with a batch file. If you want to start Xact

from a DOS prompt, instead of entering ”XACT” as usual, simply enter ”XACT

TEST.XBT”, where ”TEST.XBT” is naturally just an example and can be repla-

ced by any other batch file name.

From the Windows File Manager you start Xact batch files by double-clicking on

the name of the desired batch file. The necessary file allocation is carried out by

the Xact installation program. If you often need to call up specific batch files,

you can also create an Xact program object for each file and enter the name of

the batch file in the Properties dialog in the command line.

Sample batch files

//

// This batch file imports the file MEAS.TXT,
// sets a title and a sub-heading, calculates a
// chart using the stylesheet MEAS.STL and prints
// it out.
//
TE_OpenTable(”MEAS.TXT”);
TE_SetTitle(”Measuring site Hamburg”);
TE_SetCaption(”measured on #DATE um #TIME”);
GE_UseStylesheet(”MEAS.STL”);
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PR_Print(1);
SH_Exit();
//
// This batch file prints all XGF files within directory on the
// standard printer.
//
PR_Print(”E:\XACT\PROJEKT\*.XGF”);
// Prints out all charts from the directory E:\XACT\PROJEKT on the
// standard printer. See following description of PR_Print()!
SH_Exit();
// Exits Xact; this also completes the execution of the batch file.

Summary of functions

TE_OpenTable(”Filename”);

Opens the table with the name given. The import function is called up automat-

ically for foreign formats and ASCII files.

TE_SetTitle(”Text”);

Sets the title of the active table. If no table has been opened, the function has no

effect. To insert the date and time automatically, you can use?”#DATE”

and?”#TIME” as dummy variables in the text. Each time the batch file is

executed, the dummy variables are replaced by the current values.

TE_SetSubTitle(”Text”);

As for TE_SetTitle, but for the sub-heading.

TE_SetCaption(”Text”);

As for TE_SetTitle, but for the caption.

TE_SelectAll();

Selects and defines all columns in the table from left to right as Y columns.

TE_Select(Column number,Column type);

Selects a column and defines the column type desired. Column type options are:
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COL_NONE No column

COL_X X column

COL_Y Y column

COL_Z Z column

COL_DEV Deviation column

COL_DEVPLUS Column for positive deviations

COL_DEVMINUS Column for negative deviations

COL_DEVX Column for deviations parallel to X axis

Similarly, if a column is to be assigned to the right axis, use the column types

COL_OX, COL_RY, COL_RZ, COL_RABW, COL_RABWPLUS, COL_RAB-

WMINUS and COL_OABWX.

• ·If you want to mark almost all columns as Y columns and only a few in a dif-

ferent way, you should first use the function ”TE_SelectAll”. Afterwards you

can mark individual columns as X or Z columns with TE_Select.

GE_UseStylesheet(”Filename”);

Calculates a chart from the table opened with TE_OpenTable and the named

stylesheet.

GE_OpenGraph(”Filename”);

Opens the graphics document Filename.

GE_Recalc();

All the charts within a graphics document are recalculated. All links to tables

and their own links are updated beforehand.

GE_ChgText(”New Text”, ”Object name”);

Replaces the contents of an already existing text called Object name by the text

New text. This presupposes that the text object in the graphics window has the

name indicated (entry in the context menu under Position/Properties).

GE_Export(Parameter list);
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Exports one or more graphics windows. Wildcards such as ’*’ or ’?’ can be used

when naming the source file. One application of this, for example, would be to

export all the graphics documents (*.XGF) of a directory. Please read the section

Batch Export graphs in the Online Help for more information on the parameter

list.

PR_Print(”Filename”);

Prints out one or more graphics windows on the standard printer. If no filename

is entered, Xact prints the content of the uppermost window. The filename may

contain wildcards such as ’*’ or ’?’

SH_Exit();

Exits Xact; this also ends the execution of the batch file.

Refining batch files

If you have any requests or suggestions concerning the batch files, please get in

contact with us. However, for sophisticated automation requirements we recom-

mend either the C or REXX interface. An interface to Microsoft Visual Basic is

being prepared.

REXX macros

Macros generally consist of a sequence of commands that either fully or partial-

ly replace manual work with a program.

They are used in particular for automating frequently recurring applications or

for tasks that would be difficult or impossible to manage by hand.

With OS/2 the obvious tool for this purpose is the REXX programming langua-

ge. The advantages are as follows:·

REXX is supplied as part of the OS/2 package. After the installation of OS/2 an

online reference can be found in the Information folder on the user interface.·

REXX is easy to learn and can be used for many purposes. Many users therefore

already have a basic knowledge.·

REXX procedures can be entered with the system editor and do not need a

compiler – they are therefore directly executable.·

Overview: Reusing & Automating Documents Page 73



Using REXX as the macro language not only enables a macro to be run sequen-

tially, but also allows conditional statements, loops and subroutines.

In addition to the normal language content of REXX, Xact also provides

functions for processing tables as well as for creating and printing out graphics.

On example of using this would be to read data from a test record, enter them

into a table and then create a chart by means of a stylesheet. On the other hand,

there is also the option of reading data from a table, performing various

calculations and then entering the results in a new table. The individual

functions are described in the Online Help.

To start a macro, call it up from Xact with the REXX macro function in the

File menu. Here an identification code is transferred for the window from which

the macro was started. This identification is needed if you want to work with

this window, i.e. write and read data or inquire about and set definitions and

selections.

Working with REXX macros can best be explained with the aid of a short

example: the following procedure is intended to open a table, select and define

several columns and then create a chart using a stylesheet.

/*************************************************
* Xact Macro
*************************************************/
Parse Arg window
tHandle = XR_OpenTab(”TABELLEN\N10G8.XTF”)
Call delDefinitions tHandle
Call XR_Select tHandle, 1, 10, 1, 5
Call XR_SetColTyp tHandle, 1, ”DEVL”
Call XR_SetColTyp tHandle, 2, ”XL”
Call XR_SetColTyp tHandle, 5, ”YL”
gHandle = XR_UseStyleSheet(tHandle, ”STYLES\LINE1.STL”, 1)

Return
/*************************************************
* delDefinitions
* deletes all column definitions within a table
**************************************************/
delDefinitions: procedure
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Parse Arg tHandle
numOfCols = XR_NumOfColumns(tHandle)
Do i = 1 To numOfCols-1
Call XR_SetColTyp tHandle, i, ”NONE”

End
Return

The first 3 lines contain a comment. It gives a signal to OS/2 that a REXX

procedure is involved. The contents are of no significance.

In the fourth line a parameter is imported. In this case it is the identification of

the window from which the procedure is called up.

In the fifth line, an existing table is opened. The result of this function is

returned as the identification of the new table window.

Line 6 calls up a REXX function that deletes any existing column definitions.

Line 7 selects lines 1 to 10 and columns 1 to 5. The three following instruction

lines define 3 columns as deviation, X, and Y.

In line 11 a chart is created with the aid of a stylesheet. The result of this

function is returned as the identification of the new graphics window.

The following line ends the procedure.

After this comes the function that deletes any existing column definitions.

The first line defines the function.

In the second line, the identification of the table window is imported in which

the definitions are to be deleted.

The third line requests the number of columns which contain at least one value.

The following three lines form a loop in which the definition of each individual

column is deleted, the last column ends the function.

In the MAKROS subdirectory you will find more examples that explain how to

work with REXX.

The REXX instructions SAY and PULL are processed in the form of dialogs.

Xact gives error messages from the REXX interpreter as an output in the form

of a dialog.
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Axes

In this section we want to give you a general view of the various options

available for displaying axes. The legibility of charts depends to a large extent

on a suitable method of display for the axes. Certain conventions have become

established for the presentation of axes, which vary according to the application

concerned, and you as the user both ought to and have to be aware of these.

For each chart, Xact can generate up to two automatically drawn Y axes and

two X axes. The position of the axes to the chart is already specified in the table

via the columns definitions (see also the section on ”The Table Editor”). Here

you can use the column definition to select whether you want the Y axes to be

drawn on the left and/or right, and the X axes to be positioned at the top and/or

bottom. If you have selected one of the 3-D chart types, the axes appear with an

adjustable wall.

If you want to show extra axes for a chart, there are two methods available for

2D charts:

• You can superimpose additional charts on top of an existing one. And

this is how it works: select an existing chart. Choose the Copy command in

the Edit menu. Xact will then ask you a question, which you should answer

with Copy entire chart. If you then enter Paste in the Edit menu, a duplicate

of the existing chart will be placed directly on top of the original.

Further steps: change the name of the upper chart in Links... (to prevent any

confusion) and the column definitions, as necessary. Delete the title of the up-

per chart in its Title dialog, which is no longer needed, by emptying the con-

tents of the text fields. Push the legend to a suitable position. In Axis setup,

move the axes by the desired amount on the Scaling page.

• Duplicate the existing axes and position them as required. To do this,

you will the find entry Clone axis... in the context menu for any axis. Cloned

axes can be scaled as required without affecting the graphs. You can then

remove them again with the Delete axis option in the context menu of a clone.
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Changing axes

The graphic elements that belong

to an axis are summarized in groups,

as shown in the adjacent figure. (The

groups for grid lines also belong to

ticks or subticks).

After you click the right-hand mouse

button on an element of the group concerned, the relevant context menu will

open up. In the middle group of this menu you will find the available settings.

If, for example, you change the line style in the ticks group, this change will

affect all the ticks on the axis. Using Axis setup… you can open the Axis dialog,

which enables you to make changes to all the axis groups.

The large number of possible settings for axes may prove to be annoying – they

are there because a lot of adjustments have to be made before the layout of an

axis exactly matches your needs. The pipette tool in the left-hand toolbar

provides additional help with these. You can use the pipette to transfer all the

parameters for one axis (length, scale, optical features…) to another axis of the

same type. For example, in this way you can only transfer the features of a

Y-axis to another Y axis, and those of an X-axis only to another X-axis. You will

find more information on the pipette tool in the section Overview: Help func-

tions for charts and of course in the Online Help, too.

The best solution is to prepare some charts with the desired axis settings for

your own personal layout. If you then have to prepare a new chart, you simply

”pipette” the desired layout onto the new axes!

The position of the axes to the chart may change according to the method

used:

• Numeric: In the Axis dialog under Axis presentation on the Scaling page,

you can enter an appropriate – positive or negative – value for Move axis:.

• Manual: In the context menu for the chart, first unlock the Frame group, se-

lect the group for one axis and move this with your mouse or the arrow keys

(see also the ”Quick Start” section). The following tip may help when using

the mouse to move the axis: before moving the axis, select the Grid options…

Axis are made of maximum four groups:

0 20 40 60

The Title of this axis

Axis line

Subticks (may include labels)

Ticks (may include labels)

Axis title
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in the Page menu and check the Relative grid option. Then check Show grid

in the lower control bar of the window. All objects can then only be moved re-

lative to their starting position by the set interval!

As a general principle, you can make all adjustments for the actual axis display

in the axis dialog. You access this dialog via the context menu entry Axis setup…

or with a double click (see also the Quick Start… section).

The number of possible settings in the axes dialog is very extensive. Please

read the section entitled Axis dialog in the Online Help for more detai-

led information!

The Axis dialog is divided into se-

veral pages, each with their own sub-

headings:

• Scaling: Here you will find set-

tings for the numerical and optical

scaling.

• Division: Here you can determine

the numerical divisions and hence the position of ticks and subticks on the

axis. You can select logarithmic scales or completely free divisions: you decide

for yourself where the ticks and labels should appear on the axis.

• Ticks: You will find all the setting for the long graduation lines on an axis as

well as the settings for grid lines originating from the ticks.

• Subticks: In analogy to Ticks, this page contains the settings for the short

graduation lines.

• Help lines: Here it is possible to select three freely definable lines (with la-

bels) per axis.

• Labels: Under General you will find the settings that apply jointly to ticks

and subticks. Under Settings for: you will find various parameters that have

an effect on the lettering for ticks and subticks separately.

• Axis title: Each axis can be given its own title. You can enter and design the

text in this window – the text field has its own context menu for this purpose.

You can also adjust the position of the text to the axis from here.
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• Axis break: In most 2D charts you can insert a break into an axis. The partial

axes produced can also be further scaled as required. The newly created

partial axes can in turn be broken, so that they too generate partial axes.

We would now like to show you a set of examples for

typical axis displays with some tips on how to achie-

ve them in Xact. We have deliberately not varied the

font and line styles used so that you can recognize

the main differences more easily.

Let us first look at Figure 1. You see the actual

axis (consisting of the axis line, the graduation lines

and sub-divisions, the labels (the numbers on the

axis) and the title (in this case: Depth…). In the Axis

dialog you can adjust the properties of the axis line

on the Scaling page, and the length of the graduati-

ons on the Ticks page. On the Labels page you can

set the properties of the numbers, on the Axis title

page any extra lettering. Among the properties you

can set on the Scaling page are the length and the

starting and finishing values, on the Division page there are the number of

subticks and the type of scaling for the axis.

In Figures 1 to 4 the axes have a linear scale, starting at a value of 0 and

finishing at a value of 100. The individual settings of the original drawings

(standard setting is a tick length of 2mm, ticks outsi-

de):

• Fig.1: subticks: 5, Labels: right aligned with 2 mm

spacing, angle 0 degrees, Axis title centered paral-

lel to axis

• Fig.2: subticks: 2, Labels: top position, caption af-

ter 2 ticks right aligned with 1.5mm spacing, ang-

le 0 degrees, Axis title parallel to axis at bottom

• Fig.3: subticks: 2, labels with 2mm spacing, angle

0 degrees, Axis title parallel to axis at top0
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• Fig.4: tick length: -2mm, subticks: 2, Labels: flush

with axis at a spacing of 1mm, angle - 20 degrees,

Axis title centered at right angles to the axis

Figures 5 to 7 have logarithmic scales, starting at

the value of 0.1 and finishing at 100. The individual

settings of the original drawings:

• Fig.5: logarithm to the base 10, subticks: 2, La-

bels: aligned right with 1mm spacing, angle 0 de-

grees, comma as decimal separator, Axis title at

right angles to axis with left alignment

• Fig.6: logarithm to the base 10, subticks: 1, La-

bels: left alignment with 1mm spacing, angle 0 de-

grees, scientific presentation activated, no Axis title

• Fig.7: logarithm to the base e, tick length: - 2 mm, sub-

ticks: 1, Labels: label after 2 ticks, left alignment with

1mm spacing, angle 0 degrees, scientific presentation

activated, no Axis title

• Fig.8: logarithm to the base 2, tick length: - 2 mm,

ticks outside, subticks: 1, Labels: left alignment with

1mm spacing, angle 0 degrees, scientific presentation

activated, no Axis title

• Fig.9: logarithm to the base 10, Free division activa-

ted, list of the division: ”0.1 1{one} 10{ten} 27.3

100{hundred}”, tick length 1mm, ticks outside, subticks 1, Labels: right align-

ment with 2mm spacing, angle 0 degrees, comma as decimal separator, no

Axis title.

With Free division, as used here, you can insert Labels and ticks at any desired

points of the axis. To do this, you simply enter them in the above-mentioned list.

You can read more about this in the help system if you click on Help on the

Scaling page!
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Figures 10 to 13 have date scales, starting at the value of

1.8.1991 and finishing at 1.12.1991. The individual set-

tings are as follows:

• Fig.10: date format ”DD.MM.”, tick length: 2mm, ticks

outside, subticks: 7 (days), labels aligned away from the

axis with 1mm spacing, angle 0 degrees, no Axis title

• Fig.11: date format ”DD.MM.YYYY”, tick length: 2

mm, ticks outside, subticks: 14 (days), Labels: flush

with axis at 2mm spacing, angle 0 degrees, no Axis title

• Fig.12: date format ”DDDD, MMM. DD”, tick length:

2mm, ticks outside, subticks: 14 (days), Labels: flush

with axis at 2mm spacing, angle 0 degrees, no Axis title

Date and time scales can be selected for each axis from a

formatting list. You can extend this list with your own

formats – see Fig. 12 – and it may contain any characters

you choose. The smallest time unit is one hundredth of a

second. You will find more details in the Online Help

under Axis dialog ‘Scaling’ and under Define date/time

presentation.

Broken axes

In most 2D charts you can insert a break into an axis on the Break page of the

Axis setup dialog. The features that you can adjust include the position and the

symbol used for the break, as well as the distance from the next axis. The

partial axes produced can also be further scaled as required. The newly created

partial axes can in turn be broken, so that they too generate several partial

axes.

1.8.

1.9.

1.10.

1.11.

1.12.

Monday, Aug. 1.

Thursday, Sep. 1.

Saturday, Oct. 1.

Tuesday, Nov. 1.

Thursday, Dec. 1.

1.8.1991

1.9.1991

1.10.1991

1.11.1991

1.12.1991

Fig. 10 Fig. 11

Fig. 12

0,01 0,10 1,00 10,00

2 breaks

15 20 25 100 1.000 10.000

Page 82 Overview: Axes



Alphanumeric axes

When alphanumeric axes are shown, descriptions (rather than numerical

values) are used as the basis for the axis display. These are taken from the

legend column 0 of a table and designated as the row legends.

• This type of axis is only generated if no column has been defined as X!

As a general principle the identifiers present will be drawn on the axis in the

order in which they appear in the table. If the identifiers in the table extend

over several lines, then they will also be written on the axis in this manner. In

the figure ”Multiple-line axis labeling” we

have deactivated the entry Angle automatically

in the axis dialog on the Labels page under Gene-

ral, in Settings for: under Ticks we have set the

Angle to 45 degrees and under Align we have

selected align right.

In order to maintain the maximum clarity in axis labels with long identi-

fiers, it may be help to form categories. In this case the vertically positioned

identifiers in ”Initial state” have been entered in the table. The numbers

”1996” and ”1997” are always repeated. We can make use of this fact to create

the division of the axis shown in the lower right-hand figure.

To do this, we have altered the following settings in the Axis dialog: on the

Ticks page, the Ticks/subticks between values box has been checked and 8mm

has been selected for Length of the

ticks. On the Subticks page Length

= ½ tick length and Line style as tick

have both been deactivated. Under

General on the Labels page, a space

has been entered in the field Split

at: and Angle automatically has

been deactivated. Under Settings

for: the Text spacing for Subticks
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has been set to 0 and the Show box checked. A bold type face has been chosen

for Ticks in the Font… dialog. The Angle of 0 degrees has been set for Subticks

and Ticks.

At this point it is worth mentioning the effect brought about by entering a

character in the Split at: field: every identifier on the axis is split at the last

occurrence of this character. The identifier components that occur before the

character (in this case: I., II., III. and IV.) are drawn on the axis as Subtick

labels. Identifier components that occur after the character are drawn under

the axis as Tick labels. All the equal remainders (in this case 1996 and 1997)

are written once only and centred under the subtick labels. To separate the

identifiers ”1996” and ”1997” from each other tick marks are drawn between

them on the axis.

3-D axis systems

In three-dimensional charts you can assign a wall (or a base) to each axis.

For left and right Y axes, the Scaling page of the Axis dialog has the switch

Draw 3D-wall which enables to you to decide whether or not a wall is to be

drawn (and if so, with what dimensions). Furthermore, the switch In front

allows you to determine the position of the axes. An example with a left and

right Y axis with activated wall and base is shown below.
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Graphs

In Xact the Y columns defined in the table are depicted as different graphs

- depending on the choice of chart type. For instance a set of continuous lines or

bars is called a graph. Graphs may also be formed from several columns: for

example in an XY plot with error bars, the graph is formed from a Y, an X and

a Dev column, a set of bars in a Gantt chart, for instance, is formed from two Y

columns.

For most chart types you can gain a rough idea of what the graphs will look like

later when making the initial selection from the chart types on offer. The

available settings are of major importance when working with graphs professio-

nally. In Xact these settings are changed by means of context menus (see the

Quick Start section) and then apply to the graphs in question.

The figure below shows the context menu of a line graph as an example. The

three entries in the upper group apply to the entire chart, as does the entry in

the lower group, and these are discussed in additional sections within this

handbook. The entries in the center group apply specifically to this graph and

alter its properties:

The Mathem. Procedure-> entry of the context menu opens up further

settings, such as Regression/Fits, Interpolation, Approximation, Extrapolation

and Filters. If you are interested in this topic, please read the section in this

manual entitled Mathematical Procedures. You can also find information on

this topic in the Online Help.

Using the entry Extras->, you can determine the positi-

on of each measuring point manually with Move data

points, and you can also add or delete such points. The

altered data are simultaneously entered into a new table.

You can find out more on this topic in the section entitled

Help Functions for Charts. Show data displays the data

in this graph in the form of a table.

Line/Frame… allows you to adjust the line style, and

Marker… the type of marker. In the case of markers, the

border line and fill colors can be adjusted separately and
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even the color of the line style can be adjusted. With All graph colors… you

can alter these three colors simultaneously. Graph options… takes you to the

Options dialog specific for this grap-type.

The Caption… entry in the context menu for the graph leads to the Caption

dialog that enables you, for example, to write measured values on the graphs.

In the section Overview: Captions in Charts we provide you

with more precise information on the options for lettering in

Xact.

The list shown below appears when you select Graph style->

in the context menu. Here you can exchange the current type

of graph for another one from the list displayed. The list

contains different options, which vary according to the initial

graph. For example, this list is for a 3D chart and so both 3D

and 2D charts are offered as replacements.

Graph and chart options

Similar graphs have a common options dialog, in which specific adjustments

can be made. The settings within the context menus are only valid for the

graph selected in each particular case.

In the Chart menu you will find the entry Chart options. Settings made here

affect all graphs within a chart and therefore overwrite any settings made in

the individual graph options.

Replacing graphs by symbols

In many frequently used graphs, e.g. those with bars or markers, a symbol

from the symbol library can replace the graph. Symbols can be graphic

elements of any complexity - you will find a practical example in the section A

Simple Object Chart.

Line graphs

Linear graphs characteristically contain filled or unfilled, continuous or

stepped curves and may be fitted with markers. Linear graphs have a common

options dialog (see figure). Apart from the settings in the dialog, you can also

use those within the context menu - you will then have a very large number of

presentation options. We show a selection of these in the figure below.
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• a) The scatter plot uses markers, the

curve is a regression (context menu

Mathem. Procedures/Regression) Addi-

tional columns are defined in the table

as Dev+ and Dev-, as well as DevX for

the error bar.

• b) Only every second data point is shown by a marker - hence when there are

a lot of points, markers can be used to depict sets of data, without the graph

being made illegible by too many markers (Settings in Chart options)

• c) Markers can be replaced by any symbol you wish (see section ”A Simple

Object Chart”), the curve is a spline (context menu Mathem. Procedures/In-

terpolation…)

• d) The graph here is distinguished by the line style, the markers have been

deactivated (context menu Line/Fra-

me…)

• e) If any measuring values are missing,

the lines can be set so as not to show be-

tween the measurements concerned

(setting in Graph options…)

• f) Data points can also be represented

by perpendicular lines (setting in

Graph options…)

In the Marker selection (context menu

Marker… , see figure on next page) you

have a choice of eighteen different basic

types in any desired size, which you can

vary with Fill style… and Line style… .

Nevertheless – sometimes special mar-

kers are needed that are not included in

the standard selection. In such cases you

can use the mouse to drag a symbol of

Positive deviation

Negative deviation

Missing value at
positive deviation

a)

b)

c)

f)

e)

d)

Deviation in
X-direction
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your choice from an opened Symbol win-

dow (open by selecting Symbols... in the

Object menu) onto a graph. The graph

concerned is indicated by a frame on the

screen. Release the mouse button and

the markers on the graph are replaced

by the symbol selected. In the Marker

dialog you can then adjust the size of

the symbol, instead of that of the mar-

ker. You can also read up on this in the

section entitled A Simple Object Chart

later on in this manual.

Bar graphs

Bar type graphs are used in the chart category Bars… and in some of the

types included under Special… . Error bars can also be presented in bar

graphs. Bar-type graphs have a common options dialog. Bar graphs can also be

displayed as triangles in the 2D variants, and as columns, pyramids or hollow

bodies with up to 64 angles in the 3D

variants. This dialog enables you to ad-

just the breadth in all bar graphs (for 3D

charts the depth, and the distance of a

graph from its predecessor, too). Further

settings on 2D graphs make it possible to

offset the graph concerned and provide a

visual indication that the graph

“overshoots”, i.e. continues beyond the

range displayed.

The effects of some of these settings are shown in the illustration overleaf. We

have restricted ourselves here to the more unusual displays as your are no

doubt familiar with standard bars. Each of the graphs in the figure represent 3

numbers in relation to one another. Each of the 3D displays is illuminated.

The upper four figures show stacked bars in 3D and 2D displays, d) is a pointed

column display with a hexagonal base. In g) every graph (each bar series) has a
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different width, c) consists of tu-

bular column with a 64-sided

base and a wall thickness set to

1mm.

b) and f) are both based on

the From average chart type. The

fill styles used in f) are a mixture

of Hatches and Covering, whe-

reas b) consists of pentagonal co-

lumns. In e) - from 2D rows - the

graphs have been given color

gradations with different angles.

Different widths have also been

set for the graphs, and they have

been pushed together using diffe-

rent offsets.

Figure a) - chart type City

Block - consists of hexagonal illu-

minated columns, where the

breadth and depth of the graphs

increases from front to back.

In Figure i) the Indicate

overshoot switch in the Graph

options has been activated. The

corresponding Y axis has a bre-

ak.

Apart from the settings presented in the options dialog, you can also use the

settings in the context menu for designing your graphs.

a)

b)

c)

d)

e)

f)

g)

h)

i)
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Legends in Charts

Legends help to uniquely identify graphs and thus make charts easier to

read. You will find the entry Legend… in both the Context menu for the chart

and in the Chart menu. A multi-page dialog is available for adjusting the

position and appearance of the legend.

General

On this page you can make basic decisions on the appearance and font style of

the legends.

If you have selected None for Frame

and then Ungroup frame group in the

Context menu for the legend, you can

position the individual legend entries

freely.

Incidentally, the line and fill styles

for a legend frame are defined via the

entries in the context menu for that

frame!

Options

Under Placement you can determine the type of distribution for the individual

legend entries within the legend frame.

In the case of Circular charts you specify the diameter of the circle on the edge

of which the legends are drawn. This

presupposes that you have also selec-

ted a circular legend in the options

for circular charts. If you have used

fits or regression in a chart, you spe-

cify under As additional legend whe-

ther a numerical output should ap-

pear next to the chart. In this case

you adjust the number of Decimal

places to be displayed at this position.
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Color legend

If colors have been allocated to the values in certain chart types - e.g. Li-

nes/Markers with the marker colors switched on according to Z values - this

page will be added to the legend dialog.

The features that can be selected inclu-

de the position, the color legend for the

diagram, its width and not least the

type of presentation. The legend object

created will be of the legend axis type

and can be scaled in just the same way

as an axis. The colors can be altered via

the Fill style. option in the context

menu for the object.

0

5

10

15

20

25

30

35

40

1999-1 1999-7 2000-1 2000-7 2001-1

0

10

20

30

40

50

60

V
al

ue
s

by
co

lo
rs

Param.2

Page 92 Overview: Legends in Charts



Lettering in Charts

In this section we aim to give you an overview of the captions used in charts.

Captions in charts are either created automatically by Xact or – if a chart is

being recalculated – are taken from the table editor.

Lettering from tables

Captions that originate from an Xact table (i.e. table texts) contain information

on font styles and formatting. A cell in a table may for example contain

superscripts or special characters, may have multiple line spacing or a variety

of colors. If the text from a table cell is used in a chart, the features named above

will also be used in the following chart groups, with the exception of the font

size and colors:

• Alphanumeric axes (usually X axes): these adopt the contents of the row le-

gend - if no X column has been defined. The font is adjusted in the Axis setup

dialog on the Labels page, using Font…

• Legend letterings: these generally adopt the contents of the column legend

for the Y columns. The font is adjusted in the Legend dialog on the General

page, using Font style…

• Captions on graphs: if the Insert row legend switch in the Caption dialog

has been checked, the content of the respective row legend will be written

onto the graph. The font is adjusted in the dialog, using Font style… .

Axis titles, however, are always reproduced in the original size and color of the

table after the recalculation operation! The font is adjusted on the Axis title

page of the Axis setup dialog in the text

entry box - here you can determine the

appearance of each individual charac-

ter.

If you alter captions in charts via the

Font type and style dialog shown over-

leaf, pay particular attention to the two

switches Change font and Size. After
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you exit the dialog with OK, the fonts will be affected according to the position

of these switches:

• Size: if this is checked, the size of all characters in the affected text will be

altered to the selected size.

• Change font: if this is checked, all the characters of the text concerned will

be changed into the font type selected – characters from other font types (e.g.

from the symbol characters sets) will converted into the selected font type! If

this switch is not checked, the font does not change.

Automatic captions

In the following chart groups Xact generates captions automatically from

the figures in a table:

• Numerical axes: the font is adjusted in the Axis setup dialog on the Labels

page, using Font… .

• Captions on graphs: the font is adjusted in the Caption dialog, using Font

style… .

The desired number format in automatic

captions can always be adjusted via For-

matting. In the Number format dialog you

can set the separators for thousands and

decimals, the decimal places, etc. You can

also enter the symbols placed before and

after the figure concerned and set their

font types and sizes. These are displayed

in Example in the actual size with which

they will be inserted into the chart.

If at a later stage you decide to change the caption you have created with Font

style…, do not forget the above-mentioned effects caused by the switches Chan-

ge font/Size in the Font type and style dialog. In the case of more complex

symbols with different font sizes, colors and styles, it is therefore advisable to

specify the automatically generated font style and then you should define the

symbols.
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The Table chart type is a special case. It does not contain any automatic

captions, only text and formatting from tables.

Captions and spacing.

In almost all the dialogs that are concerned with captions in charts you will find

a button labeled Spacing... . It opens up the adjacent Text-frame setup dialog.

Under Margins you can set the distance between

the text and the surrounding frame (if you have

made this visible by checking Draw line under

Line/Frame...). The Line spacing can be altered

here, but only affects texts containing several

lines. Under Text frame you can choose whether

this length of text should be kept constant or adap-

ted. This option is not always available.

Captions on graphs

Captions may differ greatly in character according to the type of graph. The

options and settings available in the Caption dialog are therefore dependent

upon the chart type and graph. If this dialog is called up via the context menu

of a chart, the settings only apply for that graph. However, if the dialog is called

up from the Chart menu, the settings apply to all graphs in the chart – and will

overwrite any previous caption options that may have been set for individual

graphs! Please refer to Dialog ‘Caption’ in the Online Help for further details of

the dialog.

Under Placement you can select the position at which the caption is to be

entered. Here object is used as a general term for a measured value on the

graph. Hence, in a line graph, ob-

ject means the position of a mar-

ker, whereas in bar charts it me-

ans the end of a bar.

Under Formatting you can select

what is to be used as the caption,

Font allows you to set the details

of the font used.
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Mathematical Procedures

The context menu of a line graph

for example includes the entry ’Ma-

thematical procedures->’ . If you hig-

hlight this entry, the adjacent

context menu will appear. From

here you can access a range of im-

portant methods for analyzing and

altering graphs. After you have se-

lected one of the entries, the appropriate operation will be performed. (Where

the entry is followed by three dots (…), a dialog is called up.) You can look up

more precise information about the given functions and procedures in

the Online Help! The following section gives an outline of the entries and their

functions:

Regression/Fits

Basically the fit uses all the data points of a graph that lie within a definable

range of the X axis. Apart from the fit procedures listed under Methods in the

box below – and depending on which of them is selected – the following methods

are also available in the Regression/Fits dialog:

• Minimize by: -least square (sum

of the squares of the deviations), -

absolute deviation (sum of the ab-

solute values of the deviations),

-Lorentz distribution (sum of the

deviations evaluated according to

the Lorentz distribution) are the

methods that can be used.

• Use weighting: the Y value of a

data point can be given an indivi-

dual weighting. The weightings

are entered into a column defined
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as the Dev. Column. A factor of 1 weights the deviation by 1, a factor of 10

would only affect the value of the Y measurement by 1/10.

• Results:

The numerical output of the fits can be written As additional legend or cumula-

tively in a Results window. The output includes the quality of the fit, the

coefficients calculated with errors, variances and standard deviations of the

residuals, correlation coefficients with level of significance and degrees of free-

dom.

If Show data is activated in the Extras-> entry of the context menu or in the

Chart menu, the residuals and the equations of fit containing numerical details,

among other information, are displayed in a table.

The following methods are available:

• Linear fit

Linear fit is also known as ”forecast”, ”linear regression” or ”polynomial regres-

sion of the 1st degree” and corresponds to the regression equation f(x)= a + bx.

It involves trying to draw the best possible straight line through the measured

values. Using X/Y-error entries you can determine whether you wish to make

an error entry in the X and Y direction for every data point. The error entries

are expected in DevX and DevY columns.

• Polynomial fits

Non-linear relationships can for example be approximated via polynomial re-

gression of a higher degree. In polynomial regression of the third degree, for

example, the Y values of the readings are estimated with the following equati-

on: f(x) = a + bx + cx^2 + dx^3. Xact can be used for calculating polynomial

regression analyses up to the 26th degree. The following algorithms for calcula-

ting the polynomial parameters are available:

- Discrete regression: This algorithm (full name: discrete polynomial regres-

sion) is characterized by the fact that it is particularly stable with high degree

polynomials and has very small coefficients.

- SVD method: This algorithm (full name: singular value decomposition), in

addition to its high stability, also enables the standard deviations to be output

as single parameters.
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• Non-linear fits

A large number of more complex relationships cannot be described with polyno-

mials. With Xact you can either select from a list of predefined fit formulas (with

automatic determination of the Start values ) or perform the fit to your own

formulas. Up to ten parameters

can be fitted at the same time. Se-

lection of the Formulas and Start

values as well as the abort criteria

and algorithms (Simplex or Leven-

berg-Marquadt) takes place in the

adjacent dialog.

We go into these complex proce-

dures in some detail in the section

on Regression, later in this manu-

al.

Interpolations

Interpolation methods are use on line charts and can be selected in the context

menu of, say, a line graph under ’Mathematical procedures->’. This involves the

initially straight connecting lines between the individual data points being

replaced by ’round’ curves. In addi-

tion, Xact offers a choice of Cubic

spline and Akima spline interpola-

tion methods. It is also possible to

indicate the range of the X axis

within which the interpolated cur-

ve will be drawn.
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Approximations

The purpose of approximations is to match a set of data to a curve. They can be

selected under ’Mathematical procedures->’in the context menu of a line graph,

for example. Generally the

aim is to draw a curve between

the measured values that is

”pleasing to the eye”. Often ap-

proximations are used to opti-

cally compensate for disrupti-

ve random fluctuations. The

FFT filter methods discussed

in more detail below are usual-

ly also well-suited to this task.

• Spline approximation

Here, a cubic spline is fitted by means of nodes previously calculated from the

measured values. You can adjust the margin of fluctuation of the curve drawn

with % of original variance. At 100% the calculated nodes lie on the data points,

at 0% the nodes lie on a straight line. You can also assign an individual

weighting to each data point: if a Dev column has been defined and selected for

a Y data column, the figures contained there will be used as a weighting factor.

In this case, the values in the Dev column will no longer be drawn on the graph

as deviations. A factor of 1 weights the Y data point by 1, a factor of 10 would

only affect the value of the Y measurement by 1/10. If no measured value is

present, or the value in the Dev column is 0, the weighting is set to 1.

• Savitzky-Golay Filter

This method of approximation is used particularly in spectroscopy. It is also

known by the name ”DISPO” (digital smoothing polynomial) filter or ”least

squares filter”. It removes random fluctuations from measured values, while

still retaining very good local minima/maxima for the data.

The parameter Number of data points for window width enables you to set the

range from which measured values will be gathered for approximation. If for

example a value of ”13” has been entered here, the six values to either side will

be used for each node to be calculated. Therefore the number of data points
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must always be uneven. Correspondingly fewer values are employed at the

extremes of the range of measured values. The width of the window should also

vary according to the details to be represented in the data material. To do this,

you will need to determine the breadth of the peak of the curve which is to be

displayed (in data points), at approximately half the peak height. Then as a rule

of thumb, for a 4th order filter (see below), the width of the window should be

between 1 and 2 times this width.

The parameter Order determines the weighting with which the surrounding

data points are used for the node. The weighting uses a polynomial, the order of

which is adjusted here. It makes sense here to use values =2. Providing suitable

window widths have been selected, the best results are generally obtained using

an order of 2, 4 or 6. As is the case with a polynomial, both higher orders and

odd-number entries often result in overshooting and hence to imprecise filte-

ring.

If regression or non-linear fits are used, these are calculated using the smoothed

data!

• Moving average

In this case the Y data points within the window width (see above) are used in

calculating each of the nodes for the approximation curve. The arithmetic mean

of these values is calculated in the process. Here too, the space after Window

width is used for the (odd!) number of the values used. Correspondingly fewer

values are used for the calculations at the left and right edges of the distributi-

on. If regression or non-linear fits are used, these are calculated using the

smoothed data!

• Smoothing

Here the weighted harmonic mean (so-called 1-2-1 smoothing) is calculated for

X and Y from three measured values in each case. Higher orders of smoothing

can be entered after Order.

The algorithm for the smoothing is: 1st order: (value 1 + 2*value 2 + value 3) / 4

= new node. 2nd order: the nodes smoothed by the 1st order are again smoothed

according to the same algorithm, etc. One node is lost at both the beginning and

end of the graph for each smoothing step. If regression or non-linear fits are

used, these are calculated using the smoothed data!
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Extrapolation

Extrapolation is the name given to methods that analyze the existing data and

use it to calculate additional figures. They can be selected in the context menu of

a line graph for example under the Mathematical procedures-> option.

With the Regression and Non-linear fits in Xact you will find methods that you

can use for this purpose. However, they do presuppose a knowledge of the

mathematical principles for fluctuations within a set of data, and this condition

is often not satisfied. Linear prediction is a method offered by Xact that is

particularly suitable for extrapolating steadily changing sets of data which have

distinct periodicity. Examples include all data that are subject to time fluctua-

tions – from economic activity through seasonally fluctuating data (sales, tem-

peratures) to high and low tides. You can find more information on extrapolati-

on in the Online Help under the headword Extrapolation.

To demonstrate the procedure, we shall use the

data set shown in Figure 1, which was calculated

for 300 X values.

Select the Extrapolation… entry under Mathe-

matical procedures-> in the context menu of the

graph. In the Extrapolation dialog check the Cre-

ate data option. In the Source range indicate

which data range you wish to use for future

estimates - in this case 0 to 200. In the Target

range you specify the final X coordinate up to

which you wish to calculate figures - incidental-

ly, the first figure calculated follows on from the

end of the target range. Enter 300 here. You will

obtain what you see in Figure 2 as a result. The

estimated values between 200 and 300 are

shown as a white curve.

As you see, the estimated values (the white cur-

ve) deviate more and more from the actual func-

tion as x increases. The estimation is based on a

function that aims for the best possible fit with

the source values, the values of which can be
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adjusted in the Extrapolation dialog with the parameter Number of poles. The

following applies to this number – it is dependent upon the quantity and

complexity of the data: the greater it is, the more numerically unstable the

prediction will be, but the greater its accuracy. Overall, the stability of the

prediction falls with increasing amounts of data. There it is wise to vary this

parameter experimentally for each data set and thus achieve an optimum fit at

the end of the range.

On the basis of the experience mentioned above, we opted for 24 poles in

Figure 3, so as to predict in a target range up

to 400 from a source range of 0-300.

You can obtain the numerical results of the

extrapolation as a table for further processing if

you click on the entry Extras-> Show data in

the context menu of the extrapolated graph.

• Using extrapolated data

As you have seen from this simple example, a ”good eye” can be very helpful for

obtaining a meaningful estimate. Of course the validity of the estimated data

will have to be assessed very carefully. However, if they are relatively small in

number in relation to the source data, and if plausible results are obtained

when they are used, then missing data can be easily estimated and meaningful

prognoses produced.

FFT filters

FFT filter methods are used in data sets for

highlighting and suppressing information, or

for separating individual items from one

another. They can be selected in the context

menu of a line graph for example under the

Mathematical procedures-> option. For instan-

ce, they can be used for removing the noise

(measuring errors) from a set of data or separating overlapping signals from one

another. Xact offers high-pass, low-pass and band-pass filters as well as band-
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stop filters, which can all be combined with one another as required. Filters

work in a similar way to an equalizer or the bass and treble controls of a stereo

system.

The filters in Xact are based on fast Fourier transformations (FFT). These

methods determine the frequencies and amplitudes that occur in a set of data

and present the results in Xact as a periodogram (Fourier analysis). The set of

data itself can then be recalculated from the frequencies and amplitudes (Fou-

rier synthesis). If the amplitudes found are altered before the synthesis, then

the data set will change as well. This process is known as filtering.

We would like to give an example to illustrate what has been said above. On the

previous page you will find the original set of data used. It consists of a

sinusoidal oscillation and some added random values. Now if you want to filter

a set of data less subjectively than by using your ”eye”, you should first take a

look at what the frequency chart looks like. It shows the distribution of the

amplitudes at the various frequencies.

• Creating and analyzing a periodogram

First we create the periodogram shown be-

low by selecting the chart type Fourier ana-

lysis (Special entry in the Chart menu).

The lower part of this chart shows the am-

plitudes of the frequencies that occur in the

set of data, and the upper section the phase

angles for the amplitudes. In this case the

phase angles are of no further interest to us.

There are a large number of low amplitudes

(approx. 0.1 Herz) in the chart, which are

spread over the entire frequency range. This

type of roughly uniform amplitude distribution is often an indication of noise -

it consists of many different frequencies. There is a distinct amplitude peak at

the frequency of 0.125. Precise knowledge of the frequency is important in this

case because we want to try and isolate this frequency as accurately as possible

from the remaining signal.

0,0

0,1

0,2

0,3

0,4

0,5

Periodogram (Frequency presentation)
-200

0

200

Angle in degrees

0,0 0,1 0,2 0,3 0,4 0,5

Page 104 Overview: Mathematical Procedures



To do this, we will rescale the X axis of the chart: after a context click on an

element of the X axis, we can set the starting value for From: to 0.1 and the end

value at To: as 0.2. In addition, we also check the box for Draw perpendicular

lines in the Graph options menu for this chart and can thus easily read off the

frequency with the highest amplitude from the X axis. Here we are presuming

that the hidden signal is located in the noise and we will use this value for the

filtering.

• Using the band-pass

We return to the chart for the original set of data and select the FFT-Filter from

Mathematical procedures-> entry in the context menu. We can then choose from

various types of filter in the Filter dia-

log. As we now want to show the fre-

quency with the highest amplitude, we

reduce the amplitudes as far as possi-

ble before and after the desired fre-

quency (to the left and right of 0.125

Hertz). We therefore select the Band

pass page and check the first band

pass under No.. As the amplitude is

not to be altered, we retain the num-

ber 1 under Factor, and the preset va-

lue is also retained under Slope; as

this is the maximum achievable edge

slope. For Start and End we type in

0.125. You can see the result in the

adjacent figure. The sine-wave signal

has been almost entirely cleared of

noise.

• Using the band stop

Another important application is the

suppression of certain frequencies of

the original signal if they cause inter-

ference. In order to obtain the noise

signal, without the useful signal, we
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use a band stop as the filter. This is what might be called the ”inversion” of the

band pass: all amplitudes within the selected frequency range are reduced,

lower and higher frequencies are allowed to pass unhindered. In the previous

figure you can see the extremely satisfactory result.

• Low and high passes

Xact also allows high and low passes, that can be used in an analogous manner.

Low passes are often very useful as a tool for smoothing sets of data and are far

superior to other smoothing techniques due to their rationally justifiable selec-

tion of cut-off frequency.

Calculating areas

Here the area beneath a graph is calculated. In order to do this, the interval

limits (with respect to the X values of the graph) are entered, and one Y value,

which is deducted when the area is

calculated. Linear interpolation be-

tween the adjacent data points is car-

ried out for calculation purposes.

Integrating

This forms and draws the cumulative curve of the graph. In this process, the

entire selected column from which the graph is formed is taken into considera-

tion. Fits, approximations, interpolations, extrapolations and filter are calcula-

ted for the integrated curve if the integrating option is activated.

Differentiating

This command differentiates a graph according to the geometric center rule. In

this way the gradient of the graph is calculated for each data point. The

gradient is then plotted on the Y axis. A gradient cannot be calculated for the

first and last data points of a graph because the preceding / following point

necessary for such a calculation simply does not exist. Fits, approximations,

interpolations, extrapolations and filters are calculated for the integrated curve

if the integrating option is activated!
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Help Functions for Charts

In this section we would like to show you some useful help functions that will

simplify your work with charts.

Displaying chart coordinates

The lower control bar in a graphics window gives you a constant display of the

current mouse coordinates (x= ,y= ) with respect to the page size. If the

mouse pointer is located within the frame bounded by the axes of a 2D chart, the

current mouse coordinates will be shown in relation to the axis system of the

chart when you press the Shift key.

The data lens for scaling with the mouse

This function saves you the time-consuming procedure of

entering the start and end values of axes in the axis

dialog boxes. In the toolbar of a graphics window (at the

left-hand edge) you will find the symbol for the magnify-

ing glass. If you keep the mouse button pressed, a fold-out menu will open, and

if you select the last symbol on the right, the data lens is activated. First the

mouse pointer will appear as a magnifying glass. If you then trace a rectangle

which contains parts of the axis frame of a 2D chart, the axes of the chart will

be rescaled to fit the selected area when you release the mouse button.

Pipette for copying attributes

The pipette is used as a simple way of transferring attribu-

tes from one item to another. It ”sucks up” all the attributes

(e.g. line and fill style) from an object and passes them on to

any other object. If you click on an object within a group

when the pipette is full, only the object in question will be

changed, provided it is not an automatically generated component of a chart.

Once a pipette has been filled, it remains so until emptied and can be used

repeatedly. Filled pipettes retain their contents even when you change from one

graphics window to another.
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In the tool bar of a graphics window (at the left-hand edge) you will find the

empty pipette symbol. When you click on it, the mouse pointer also changes into

an empty pipette symbol. When you click the mouse pointer on an item, the

pipette is filled with all the attributes of this item. Each click with the filled

pipette on an item will then transfer all the attributes in the pipette to that

object. However, if you open the context menu of the filled pipette on an object,

you can select the property you want to transfer and if necessary empty the

pipette.

Graphics attributes are transferred to the Charts by the pipet-

te, according to the chart group. Almost all the groups use fill,

line and text styles, and Axis styles can also be pipetted and

transferred for axes of the same type.

Axis styles contain all the settings for an axis - from the line

style through the length of the axis to the lettering. Hence

pipetting an axis enables all its characteristics to be transferred to another axis.

This saves you carrying out the numerous individual settings in the axis dialog

that would otherwise be necessary!

Moving data points

This functions lets you change the position of the data points interactively for

every graph in a 2D chart. You will find the entry Move data points under

Extras- in the context menu for a graph. When you select this, all the data points

will be displayed in a frame.

At the same time the current data of the reference points are displayed in a new

table. Data points selected in the graph are shown as filled and are also selected

in the table accordingly.

And this is how it works: after the option has been selected, the reference points

of the graph are shown as squares, which are drawn on the graph. One of the

squares is filled – this is the data point that is currently selected. A click with

the right-hand mouse button will take you to a context menu with the following

functions:

• Insert adds an extra data point.
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• Delete removes a selected data point. Delete can only be selected if the context

menu for an active data point is being used!

• End terminates this function.

Data points can be selected in a variety of ways. Clicking the mouse on one

data point selects that point, as does the key combination Ctrl + arrow

right/left. You can select several data points by drawing a frame with the

mouse. All the data points positioned within it will be selected and shown as

filled.

• The selection frame can be enlarged or reduced with the mouse horizontally

or vertically. The data points contained will move accordingly. You can use

this feature to stretch or compress measuring ranges in either the X or Y di-

rection!

You can move data points freely if there is a numerical X column in the

graph. If you only have alphanumeric labels of the X axis, you can only move the

data point in the direction of the Y axis.

You can move selected data points with the mouse button pressed or with

the left/right arrow keys. In the latter case, the step size of the movement can

be increased by pressing the Shift key at the same time.

• Please note: while executing this function you can make enlargements al-

most at will using the magnifying glass. You can thus specify the numerical

accuracy of the final version!

Showing data

This function can be selected in the Chart menu and causes the data from all

graphs to be shown. In the context menu for a graph found under Extras-> ,

only the data of the graph selected will be

shown.

If a graph has been calculated by Xact (re-

gression, fits, filters, Fourier analyses, inter-

polations, approximations, extrapolations…),

these calculated data will also be shown.

To allow you to make the settings, a Show
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data dialog opens for every graph, in which you can specify the Starting value,

Step width and End value of interpolated values as required. You can then use

the data shown in a new table in any way you want.

Quick color changes in charts

In the File menu under Preferences/Charts you will find the option Replace with

present styles on recalculation. These switches enable you to change the colors of

finished charts, such as when you want to create a black and white chart from a

colored original as a master template.

If you check one of the two boxes,

Xact will in future use the line styles

and colors currently set in Preferen-

ces/Charts under Lines/Markers

and Fills when recalculating. If you

have chosen a black and white model

there for example (or your own spe-

cial setting) with Load…, a click on

Recalc in the Chart menu will cause

the graphs in all the charts of a

graphics document to take on the

preset characteristics. This will overwrite any previous manual settings on the

graphs. In any case, texts, axis lines and legends will be shown in black

and white – this is the basic setting when charts are first created. If you just

want to change the colors temporarily, you can restore the previous settings

with a click on Undo in the Edit menu. The way in which the graph styles are

altered depends on the switch:

• Colors of line/fill styles only changes the colors of the graphs. Any existing

marker types and line styles will be retained. This function can therefore be

particularly useful for changing a color chart quickly for a black and white

printout or vice versa.

• Complete line/fill styles, on the other hand, changes all the attributes from li-

nes/fills and thus changes the graphic features of all graphs so as to precisely

match the current settings.
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Drawing & Illustrating

Xact creates charts from your data automatically. How-

ever, most charts and publications require explanations, logos

and images and thus have to be designed individually. To do

this, Xact provides you with a complete vector graphics dra-

wing program – in the following we will call this the Graphics

editor .

Here, with the aid of various drawing tools, you can insert

extra lettering or draw graphics objects such as circles, rec-

tangles, shapes or curves. All the objects within a chart, and

that also includes the tables that are created automatically by

Xact, can have their shape, color, frame or text style altered at

a later stage. Useful functions such as grids, rulers or copying

functions are there to help make your work easier.

Vector graphics and bitmap graphics

Vector and bitmap graphics are two terms that users of

graphics programs often encounter. However, they are also

terms that create a very indistinct impression for non-pro-

grammers. Nevertheless, as their meaning is very important

when working with Xact and in exchanging data with other

programs, we would like to shed some light on the matter.

Bitmap and vector graphics differ in the way an image is

saved, whether it be within the program itself or as a graphics

file, and in turn this method of saving gives rise to all the other

differences. This can explained most simply by using a line.

Bitmap graphics

In a bitmap graphics program, a line is saved as a row of

points, each of which has a certain color – in the simplest case

black and white. However, the program is no longer able to

distinguish whether this sequence of points is a line or not. To

put it another way, this program notices the color of each point

within a grid, where for example the grid could be the image

dots on a monitor.
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Consequently, bitmap graphics is a suitable for an image

that consists of complex shapes and a multitude of colors, e.g.

digitized photos. The fact that each image dot is saved also

means that its color can be changed at any time and this opens

up a wide range of special options for subsequent processing.

These might include, for example, an eraser, with which all

colored pixels in the vicinity of the mouse turn white, or a

spray can with which a few random pixels within a certain

area can be colored.

Vector graphics

In the simplest case, a vector program saves a line in the

form of four numbers, the x and y coordinates of the starting

and end points. Added to this, there is generally information

on color, thickness and the style of line as well as some identi-

fier to show that the object is a line. However, the program

does not know whether a particular point on the screen or the

printer is black or white.

Avector graphics image therefore consists of a collection of

clearly defined basic geometric objects such as lines, ellipses,

curves, formatted text, etc. This has the advantage that we

can not only change the color and thickness of our line but we

can also edit the coordinates at a later stage.

Afurther advantage is the so-called independence of reso-

lution . This means that every output device, whether it be a

screen or a laser printer, displays the line between starting

and finishing points as accurately as possible.

Vector graphics are therefore particularly useful for dis-

plays that consist of geometric shapes, a term which also

includes curves (sometimes called paths). This is for example

the case with technical drawings, organigrams and graphics

for presentations.

A brief outline: Graphics windows

In Xact all graphics objects are managed in one or more

graphics windows. The entry New… in the File menu of a

window lets you open up a new graphics window. Start Xact
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and take a look at a graphics window: it consists of several

menus , the toolbar in the left-hand frame of the window and

the status line in the lower frame. You will also see a dotted

rectangle against the white background of the window. This

marks the limits of the print area, which depends on the

printer that has been selected (File Menu, Printer preferen-

ces… option). The following is a summary of the basic menu

functions:

File:

Here you will find the functions Open , Save , Import , Ex-

port and Print . Under Document info… you can edit comments

on the current document, and in Preferences you can specify

the paths and the basic operating characteristics of Xact.

Edit:

Here you can access the functions Undo and Restore , you

can Cut, Copy , Paste and Delete objects as well as edit objects

with the special functions of Clone , Multiple cloning and Ex-

change .

Page:

The options in this menu affect the entire graphics win-

dow. Format… is where you specify the size and units of the

page. The options from Full page to Custom size… determine

the appearance of the graphics objects on the screen. The

remaining help functions assist you in working efficiently.

Arrange:

The entries in this menu refer to the position of the selec-

ted objects. The entries between Foreground and Send back-

ward enable you to change the order in which they are drawn.

Group joins objects together so as to make one unit, Ungroup

has the opposite effect. Align… and Position and size… change

the location of objects as do Rotate and Flip.
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Object:

Symbols… gives you access to the symbol libraries, which

help you to manage and easily select graphics objects. The

entries Font style… down to Marker… allow you to specify the

optical properties of objects. Convert to curves and Connect

curves are functions for changing the way in which selected

graphics objects are constructed. Combine , Cut and Round

objects let you manipulate existing objects.

The status bar shows the current mouse position within

the selected coordinate system. Show grid and Outlines only

give you rapid access to the frequently used page-specific func-

tions. Recalculate automatically lets you decide whether

charts should be recalculated immediately after each change

in the chart functions.

The toolbar in the left-hand frame of the graphics

window directs you to frequently used functions, without

your having to search in the menus. The function that is active

at any point in time is displayed in inverted colors.

The toolbar provides rapid access to the page display (ma-

gnifying glass), contains functions for creating objects (sym-

bols from rectangle to text), functions for shearing and rotating

symbols (the two bottom symbols) as well as for editing poly-

gons and curves (the second symbol from the top). If none of

these functions is active, the arrow symbol will be displayed in

inverted colors. It indicates that objects may be selected.
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Creating objects

You can create a variety of different graphics objects in

Xact. The so-called drawing tools are there to help you do this.

You can drag standard graphics items from one of the symbol

libraries directly into the graphics window or import them into

the window using the Import… option in the File menu.

When you open a graphics window you will initially find

yourself in selection mode, in which you can move and edit

objects. The drawing tools are located at the left-hand margin

of each graphics window. By clicking on the individual sym-

bols, you determine the type of object that is to be drawn.

• Open a graphics window with the option New… in the File

menu.

• ·Click on the ellipse symbol in the toolbar . It will be shown

in inverted colors to indicate that you can now draw an el-

lipse. If you keep the mouse button depressed on the ellipse

symbol, further symbols will appear for circle , segment and

arc, which you can select as alternatives for drawing.

• Now move the mouse pointer to any location within the win-

dow. To show that your are in a drawing mode, the mouse

pointer appears as a small cross-hair .

• ·Now press the left-hand mouse button to mark the upper

left-hand corner of the ellipse and, with the button depres-

sed, move the mouse across the screen to create the ellipse.

• ·As soon as you release the button, the ellipse will be drawn

in its finished form.

All other objects are produced in basically the same

way!
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The rectangle symbol also offers you a choice of the sym-

bols for drawing a square , rounded rectangle, triangle and

polygon.

For the line symbol you have a choice of the symbols for

drawing vertical , horizontal and freehand lines.

You will notice that eight black rectangles are drawn

around each object. These so-called sizing handles indicate

that the shape and appearance of this object can now be

changed. We shall not touch on these for the time being as they

will be dealt with later in the section entitled Selecting and

Moving Objects.

In the next exercise we shall draw an irregular triangle

using the polygon function. Equilateral triangles are best

drawn with the above-mentioned triangle drawing function!

• Activate the polygon symbol.

• Now mark the starting point of the polygon with a brief clicknext to the ellipse.

• Now set the next corner points by clicking the mouse on the

desired position for the lower left and then for the lower

right-hand corner of the figure.

• The finishing point of the polygon is marked by a double

click.

While you are drawing, the last corner point you set can be

erased again by pressing the backspace key.

Please read the next section on Creating a Text Object to

find out about the text tool and its derivative functions.
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Creating a Text Object

In this section we aim to give you an overview of writing in Xact. The

so-called text object is available to help you do this. A text object is just as much

a graphic element as is for example a rectangle or a line. It is also treated in the

same way by the graphics editor – it can be moved, reduced, enlarged or

arranged with other items in exactly the same manner as for other graphics

items.

Setting the attributes of a text object

Like every other graphics object, a text object has its own

specific context menu. You can set the attributes of a text frame

with Line/frame… and Fill style… . Using Font…, you can set

the font for the entire text within the object. Edit opens up the

text object and displays a cursor (a double click has the same

effect). Text editor… provides a convenient way of entering text

in a separate window without having to worry about formatting

and text angle.

Using Settings…, you can determine how the text frame reacts

when changes are made, as well as the distance between the

frame and the text.

If the text frame adjusts automatically, the size of the frame varies according to

the quantity of text; otherwise the frame remains fixed. However, it can be

changed at any time by pulling one of the non-diagonal sizing handles with

the mouse.

Pulling the diagonal sizing handles with the mouse changes the content of

the text object (the text itself) proportionally.

How to create a text object

A text object is created by clicking the adjacent symbol in the left-hand

frame of the graphics window. If you keep the mouse button

pressed on the symbol for a moment, further symbols will

appear with the following functions: with the left-hand symbol
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you create a variable text block, which adapts to the text typed in. The middle

symbol enables you to draw a fixed text block – which you can then adjust

with the mouse as required, at a later stage. The right-hand symbol lets you

specify a fixed and framed text block.

In the case of variable text frames, the mouse pointer has the form of a cursor;

otherwise it is displayed as a right-angle with a cursor. A mouse click then

positions the text object within the graphics window. At the same time a dotted

frame shows the current outline of the text object. The cursor flashes within the

frame and you can start typing in the text. If you make a mistake, you can used

the arrow keys to move the cursor within the text, to insert letters, or delete

them using the backspace or Del keys.

The text entry mode is terminated as soon as you click on the page outside of the

text object, activate a new tool or select an option from the menu.

If you click on the right-hand mouse button while editing, you can

change the text using the adjacent context menu. If nothing has been

selected within the text object, the changes made with the central

group will affect the entire text. However, Format… only affects the

paragraph in which the cursor is positioned. If you have selected

parts of the text with the mouse, the changes will only affect the area

selected:

• Superscript and Subscript raise or lower the text,

• Normal restores superscripts and subscripts to normal text,

• Color changes the color of the text,

• Font… opens the dialog for Font type and style. Note here the two switches,

Change font and Size. After you

exit the dialog with OK, the fonts

will be affected according to the po-

sition of the switches:

Change font: if this is checked, all the

characters of the text concerned will be

changed into the font type selected –

characters from other font types (e.g.
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from the symbol characters sets) will be converted into the selected font type! If

this switch is not checked, the font will not change.

Size: if this is checked, the size of all characters in the affected text will be

altered to the selected size.

The adjacent figure gives an example

of how to change the font attributes

via the options in the context menu. If

you do not select a section of text with

the mouse, the entire text will be auto-

matically displayed as selected and

changed accordingly.

• Format… opens the adjacent Para-

graph format dialog. In this window

you can set the line spacing, inden-

tation, tabulator stops and formats

such as left or right alignment. The

settings made here always apply to

the paragraph in which the selected

text is located.

• Symbol… opens the Symbol selecti-

on dialog. The Font field allows you

to select a font of your choice so that

its character set will be displayed. If

you click on a character from the

field below, this will be inserted in

the text at the cursor position. You

can also access Symbol selection by

simultaneously pressing the Alt

and Ins keys while you are editing

the text.
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Copying and inserting text

You do not have to type in every text – in many cases the texts will already exist

and can be inserted in Xact. If you select Import… from the File menu, you can

select and import texts in RTF and ASCII formats. Xact creates a text object

and fills the frame with the imported text. Texts can also be inserted into

existing text objects at the cursor position by using the functions Copy and

Paste.
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Selecting and Moving Objects

Objects that are already present in Xact have to be selected

before they can be edited. In the following you will find various

methods of selecting objects.

First of all, make sure that you are actually able to select

an object. An active (inverted) arrow symbol in the toolbar

shows that you are in selection mode. Graphics objects can be

selected by clicking on a component of the object. The selected

objects are then displayed with a selection frame.

Mouse click The simplest method of selection involves clicking on an

object – e.g. an ellipse.

• ·Please note that objects that are shown without a filling can

only be selected by clicking on their outline.

• ·General rule: objects can only be clicked where they

actually cover some space.

Selection mouse pointer The shape of the mouse pointer changes as you move it

over objects. If there is no object under the current mouse

position, the mouse pointer is shaped like an arrow. However,

if there is an object beneath the mouse pointer, it will change:

Therefore you can

tell from the shape of

the mouse pointer whe-

ther it is over an object,

and at what position.

Incidentally, the mouse

pointer also changes On the filling On a line or frame On a vertex

Shapes of the mouse pointer
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when it is in the immediate vicinity of an object. The distance

does not depend upon the zoom factor of the screen. The shape

of the mouse pointer when you select objects is of great im-

portance when moving them – we shall discuss this later!

Multiple selection You will often want to select several – or a large number –

of objects at once so as to group the objects, or set one attribute

for several objects at once, or even move the objects together.

Xact offers different methods for selecting several objects:

… with Ctrl mouse click Keep the Ctrl key pressed and click consecutively on the

objects you want to select. This methods is recommended for a

small number of objects – or if one of the other methods has

selected too many or too few objects. Ctrl + click on a selected

object will deselect it.

... by drawing

a frame If the objects are positioned adjacent to each other and are

isolated from the others, then they can be jointly selected by

drawing a frame. Note that a frame started from the left only

selects the objects that are fully included in the frame. A

frame started from the right selects all the objects it touches.

.

..

with Search Sometimes you will want to alter objects of a certain type

– perhaps ”all lines with a thickness of 0.1 mm” or all markers

of a certain type. In the Object menu you can use the Search

function in the dialog boxes for the line, fill style, marker and

text attributes to search for and select objects with specific

properties. To do this, first select one of these objects with a

mouse click and then choose Search in the appropriate dialog.

... with the arrow keys Another way of selecting is to use the arrow keys in con-

junction with the Control key. The objects in a chart are

arranged internally in a list. You can scroll up and down this

list from a selected object using Control + Up or Control +

Down. (This is also makes it possible to select objects that are
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completely hidden.) If you also keep one of the Shift keys

pressed down, all the objects you scroll through remain selec-

ted.

Deselecting objects A mouse click on a vacant position on the graphics page

deselects all the objects. If such a position cannot be found, you

can either choose Deselect all in the Edit menu or press the

ESC key.

Finding lost/hidden

objects... You will sometimes find that an object gets ”lost” behind

larger objects in the foreground. You can easily check whether

other objects are ”hiding” behind another if you activate Outli-

nes only in the control bar of the graphics window! Completely

covered objects can be accessed in several ways if you know

their approximate position.

in Outline mode First activate the Outline mode in the lower bar of the

window. In this mode you can select objects only by their edges

(outlines). In this way you can click ’through’ individual ob-

jects.

with Ctrl and arrows You can also use the Ctrl and arrow keys to select hidden

objects. Select any object in the vicinity of the one you are

looking for. Now you can ”flick through” the objects in the

order you have drawn them using ”Ctrl + Up” and ”Control +

Down” until you have selected the object you want. In both

cases you will only be able to recognize from the selection

frame whether the object you have ”found” is the one you are

seeking.

With relative grid Another method of selecting hidden objects is to push the

objects obscuring them to the side – and this requires both

Magnetic grid and Relative grid to be activated. If you have

selected coarse grid spacing, the relative grid will help you to

reposition the upper objects exactly in their original places –

this is because Relative grid accurately maintains the diffe-

rence between the position of the object and the next grid

point. When you have exposed the object you are looking for,

select it and bring it to the front with the Foreground function.
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Moving objects

…with the mouse Everything that is drawn by hand, or that is automatically

drawn by Xact, can be moved freely on the screen at a later

stage. If Show grid is checked (lower window bar), objects can

only be moved in intervals of the grid spacing and ”snap” into

the nearest grid point when you let them go. If you have

checked the Relative grid option (Page menu under Grid opti-

ons), objects will be moved from the starting position according

to the preset grid spacing.

• Draw a rectangle

• Click on the rectangle and move the mouse while keeping

the left-hand button pressed. To help you, the outline of the

rectangle is shown while you are moving it.

• After you have released the key, the rectangle is drawn in

its new position.

• If objects are not filled, you have to click on their pe-

rimeter to move them!

…multiple objects If you intend to move several objects, you have to select

them beforehand. Moving one of these objects will then cause

all the others to be moved at the same time. To help you do

this, you will see the outline of the object you have clicked,

together with a frame around all the other objects, while you

are moving the objects.

• If you notice that you have started moving the wrong

object, you can abort the process by pressing the ESC

key.

... with Clone If you press the Shift key during the moving operation, the

objects will be cloned and only the clone will be moved!

…with arrow keys Selected objects can also be moved with the arrow keys.

Here every press of the key causes the object to be moved by

one pixel. If you keep the Shift key pressed at the same time,

the objects will move ten pixels at a time.
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…with the capture

function We showed you above that the shape of the mouse pointer

changes when it moves over another object. If for example you

select a line at one of its end points with a mouse click and

then move this line to the edge of an ellipse, the mouse pointer

will change shape in the immediate vicinity of the ellipse

perimeter. It thus shows that there is a line underneath. If you

then let the line ”go” at this point, the end point of the line fits

exactly onto the perimeter of the ellipse: the line ”slots” into

the outline of the ellipse.

…with a reference point You will find an important tool for moving objects accura-

tely if you keep the selection arrow depressed on the toolbar . If

you click on the central symbol, you can set the first reference

point on an object. You set the second reference point on

another object. Afterwards a dotted line appears, the tip of

which points to the second reference point (the target point).

Press the Enter key : the first reference point (and with it the

object) is moved exactly onto the second reference point.

You can control the position of the reference points

in the context menu for reference points. The context menus

have various, different options – depending on the starting

and end points and the type of object. Here is an example:

• Center places the point in the middle of the object

• Next edge places the point on the nearest node of the object

• Divide line by two, three, four places the point precisely on

the selected divisor for the line on which the point is cur-

rently located. This makes it easy to divide line segments

without any calculating.

• Move horizontally or vertically causes the point to be

aligned accordingly and executes the move

...return key
pressed...
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• Adapt X and Y has the same effect as the Enter key and

executes the move

• Position… enables you to set the target point numerically.

When dealing with complex graphics it is particularly use-

ful to be able to indicate the target point. For example, the

origin of a chart can be set quickly and accurately to a de-

fined position!

In the example Before: After: the starting point was set

at the end of an arrow, the target point was set to approx. ¼ of

the lower edge of the rectangle and Divide line by four was

selected from the context menu. The target point thus jumps

to the nearest ¼ point on the perimeter, executes the move.

Repeating this twice resulted in the precisely positioned ar-

rows seen in After:

Moving objects using
the reference points
eases many tasks:

Moving objects using
the reference points
eases many tasks:

Before:

After:
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Objects and Groups

In Xact you can draw graphics objects as vector objects or

have them created automatically. Xact also manages bitmap

objects , in which you can change the size and color resolution.

All objects have their own context menu with frequently used

functions. If the object is part of a chart, a chart context menu

is opened. Here we shall discuss the context menus of graphics

objects.

Context menus for graphics objects

A context menu appears when you click the right-hand

mouse button over a graphics object. It consists of up to four

groups:

In the upper group you will find functions to Copy , Cut,

and Delete . This group is always available and affects all the

objects selected.

The second group offers attribute settings such as font,

fill and line style. These functions also affect all the selected

objects.

The third group is intended for functions that refer espe-

cially to the object that has been clicked, such as Edit for

example.

At the end of the context menu you will find the grouping

functions, provided you have selected several objects, and the

option Position , which, in essence, corresponds to the Arrange

option in the menu bar of the graphics window. The function

Properties is an exception. Please refer to the Online Help for

further information

• Incidentally, a right-hand mouse click brings you

back to the selection mode in most cases. It is only

when editing objects that this is not possible, since

this mode generally uses its own context menus.
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Properties of objects

You will find the option Properties… in the context menu

of a selected object (and a group of objects too) under Position-

>. Using a vector object, we now want to show you the dialog

that enables you to adjust the following properties:

Locking Locked objects are protected against changes of any kind.

They are identified by transparent sizing handles at the top

left and bottom right. If you have specified in the Page menu

that locked objects are not to be shown, you will see a frame

containing a cross instead of the locked object.

Hiding Hidden objects are not printed and can only be seen in the

outline mode. This also means that you can only cancel this

attribute in outline mode.

Help object(s) They help to align other objects, and are only displayed as

dotted outlines and are not printed.

Object name Every object can be assigned a name here. The purpose of

this name is to identify the object in connection with the

programming interface.

Combining groups – objects

Your charts will often consist of very many objects. Wor-

king with such charts would be very tedious if there were no

way of combining several objects into a group.
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• Draw an ellipse, a polygon and a rectangle.

• Select all three objects and select the function Group in the

context menu or in the Arrange menu.

• The selection frame now encloses all three objects.

In principle this group may be regarded as one object. This

means that all changes in shape, position and appearance

(apart from changes with the pipette) will always affect all the

objects of this group. It also means that several groups may in

turn be combined, with there being no restriction on the depth

of nesting.

• When a chart is saved, the grouping information is

saved too. You should therefore not shy away from

making frequent use of this function.

A group can of course also be dismantled back into its

constituent parts.

• Select the group by clicking on one of the objects and choo-

sing the function Ungroup in the context menu or in the Ar-

range menu.

• Each individual object will now have its own selection frame

again.

internal and free groups Xact distinguishes between internal and free groups. In-

ternal groups are formed automatically when calculating

charts; you can call up diagram functions such as axis scaling

in the context menu. You may choose to separate groups and

work with the individual objects as if you had drawn them by

hand. However, the chart can no longer be resized afterwards.

Free groups are those you create yourself.
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The drawing sequence is not changed when the ob-

jects are grouped. For example, you first draw a rectangle,

then an ellipse on top of it and another rectangle on top of that.

After you have combined the two rectangles to form one group,

the ellipse still covers the rectangle that was drawn first.

• Tip: if you want to alter an object in a group, first se-

parate the group, deselect the object in question and

recombine the group. After the change, you carry out

the same procedure as before except that this time

you add the object to those selected with Control +

mouse click. In this way you can avoid the trouble of

having to completely rebuild the group.
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Changing Objects

Selected objects can be changed in Xact in a variety of ways

– both in terms of their optical properties and their size and

shape. Let us start with the optical changes:

Changing optical properties

Most object types have several, independently adjustable

properties. On a rectangle, for instance, you can not only

adjust the color and type of filling, but also the color and

thickness of the edge. However, some object types (e.g. bitmap

graphics) have their own properties dialog.

You can find the properties common to most objects in the

Attributes dialogs. You can access these:

• via the Object menu

• via the context menu for the object (press the right-hand

mouse button)

It does not matter which method you use to call up the

attribute dialogs, although the context menus are often more

convenient as they allow you to alter the properties ”on the

spot” as it were – without having to move the mouse pointer all

the way to the menu.

If you have selected just one object, the attribute set-

tings relating to this object will be shown in all the dialogs. If,

for example, you have selected a rectangle with a line thick-

ness of 0.3 mm for the frame, this figure will also be shown in

the dialog for setting the line attributes. If several objects

have been selected, the dialog shows the properties for the

object positioned furthest in the background.

The values you set in the dialog then apply to all the

objects selected when you call it up.

If no object has been selected while you call up the attribu-

te dialog, the values for newly created graphics objects will

apply.
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Changing line properties

You will presumably change these properties very fre-

quently. We will therefore use a rectangle as an example in the

following paragraph to show you some of the available options.

Remember though that the rectangle must be selected before

it can be changed.

• Draw a rectangle.

• Now open the context menu with the right-hand mouse but-

ton and select the option Line/Frame… . You can select the

line styles in this dialog and/or adjust the thickness and co-

lor of the line.

• Now select a line thickness of 2 mm and confirm with OK.

• The rectangle will now be redrawn with the newly selected

line style.

• Select Fill style… in the context menu, check the covering

switch and set a different Color for the rectangle. If you

wish, you can also set a precise number for the color: to do

this, click on Setup… and select the color of your choice from

the dialog that opens. Leave the dialog with OK or by double

clicking on the desired color.

• The rectangle will now be redrawn with the newly selected

color.
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• Under Fill type you can also select Unfilled, Gradation ,

Hatches or Dots . The dialog that appears after Setup… also

varies according to the type of filling.

• The color and style of the object frame are adjusted in the

Line/frame… dialog. In this way, for example, you can cre-

ate a green/red checked filling at 45 degrees with two diffe-

rent line styles and 4 mm spacing, framed by a 2 mm thick,

blue dotted line.

Gradations and shading

Xact offers you various vectorial hatches and color grada-

tions as fill styles. You can choose between the different fill

types in the Fill style dialog.

Under Fill style you can choose from Unfilled , Covering ,

Hatches and Gradations . The Setup… button you will take you

to different setup dialogs according to which switch

you check. In the figure you can see the dialog for

Hatches . Here you can compose hatches and freely

define their Angles, Line styles, Spacing and Back-

ground.
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If you select a Gradation as the fill type, Setup… will take

you to the Color Gradation dialog. Here you can select the

starting color under From and the final color with To, the

Angle and the Method.

Marker types and sizes

Markers for indicating the nodes in line graphs are used as

independent graphics objects by Xact. Firstly this has the

advantage that the markers always retain their proportions,

regardless of whether the entire chart is stretched or compres-

sed; secondly a circular marker, for example, can be easily

transformed into a triangular marker. The only difference

between it and the other object types is that there is no dra-

wing tool for markers.

You will only rarely have to call up the Marker settings in

the Object menu because these are usually accessed via the

context menu for a graph. You will only need to use this dialog

when a chart can no longer be resized.

• Open a table, select the Chart menu, then the

Line… option and then the type Scatter before

leaving the dialog with OK.

• In the context menu of a graph select the entry

Marker …. Select a round marker and enter a 2

after Size , assuming you are currently using mil-

limeters as a measuring unit. After you have clik-

ked on OK, the markers in the chart will be

changed accordingly.
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The pipette tool

This tool enables you to transfer all the optical properties

of an object to another in one operation. Select the empty

pipette symbol in the toolbar (or press the e key) and click on

an object with the mouse. The pipette is now filled with all the

optical properties of this object. Optical properties are trans-

ferred within charts according to the chart group, and even

axis styles can be pipetted and transferred.

If you click on an item within a group when the pipette is

full, only the item in question will be changed, provided it is

not an automatically created component of a chart. Once a

pipette has been filled, it remains so until emptied and can be

used repeatedly. Filled pipettes retain their contents even

when you change from one graphics window to another.

If you open the context menu of the filled pipette on an

item, you can select the property you want to transfer and if

necessary empty the pipette.

If you click and hold the mouse pointer a little longer on

the pipette tool, you can use the filled pipette shown on the far

left – it contains all the properties last pipetted. (You can

achieve the same result with the f key). The other symbols

have the same function as the options shown in the context

menu for the pipette.

Changing shape attributes

In this section you will learn how to alter the shape attri-

butes of objects. The term used for this in Xact is editing.

Transforming objects with straight segments into

curves

Many objects contain straight segments, e.g. polygons,

rectangles, squares, stars or lines. The straight segments can

be changed into curves using the function Round objects (Ob-

ject menu). In this process, continuous transitions between the

individual curve segments are generated so that after roun-

ding, a square will look like a circle. The objects are thus
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changed into polygons, i.e. they change their object type and

can then be edited like other polygons. This function has no

effect on text objects!

Editing objects

The various objects each have their own special editing

functions. You can access these for a selected object by

• selecting Edit in the context menu or

• double-clicking on the object.

If you click on the curve editing symbol in the toolbar, you

can then select the object you wish to edit – if in fact it can be

edited.

Some object types have an additional Settings… entry in

the context menu. Rectangles and squares have no editing

function.

Now try the following example:

• Draw a polygon

• Select Edit in the context menu

• Every vertex will now be marked by a button.

• Click on a button and move the mouse while keeping the

left-hand button pressed.

• After you have released the key, the vertex will be drawn

under the button at its new position.

• You can move vertices either with the mouse or the arrow

keys (pressing the Shift key at the same time will increase

the step width).

• You can also move several vertices at once in the curve

editing mode of a polygon. To do this, select the points one

after another with the Control key pressed, or draw a selec-

tion frame around the points you want. If you then move
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one of the vertices selected while keeping the mouse key

pressed, all the points selected will follow the mouse move-

ment.

You will find important functions for editing indivi-

dual vertices in the context menu for each point of the curve.

• Insert edge adds a new point midway between the point se-

lected and the following point, Delete edge removes the point

selected.

• To line changes the segment following the point into a line,

To curve changes the segment following the point into a cur-

ve. For a curved segment you will see additional align-

ment points at the vertices. You can use these to alter the

shape of the curve.

• Cut changes the line following the vertex into an invisible

line, Join has the reverse effect. In this way you can display

hollow shapes with a single object, e.g. a filled ”A” or ”O”.

• Close links the vertex to the next point on the polygon.

• Edge on/off eaffects the two segments adjacent to the ver-

tex if at least one of them is a curve. If Edge is on, there will

be a smooth (continuous) transition between the two seg-

ments and adjacent alignment points will be moved toge-

ther. Otherwise, there are no restrictions to the movement

of the alignment points.

Enlarging and reducing

You have no doubt been asking yourself why Xact marks

selected objects with eight buttons. The reason is that these

buttons or handles are not only used for identification purpo-

ses but are also used for enlarging and reducing objects.

• Draw an ellipse
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• Select the ellipse. Click on the lower right-hand handle and

move the mouse upwards to the left.

• After this method has been used to reduce the ellipse pro-

portionally in width and height, move the lower central

handle downwards.

• The height of the ellipse is changed.

• When charts are changed in this manner, the lengths of

the axes in the chart alter.

• When text objects are changed in this way the height and

breadth of the corresponding text frame changes.

Proportional? In general the corner handles change the size of the

object proportionally . If you press the Shift key while you

are changing the size, the size of the object can be altered at

will. The central handles are used for changing either the

height or the width.

• If charts are changed proportionally, both the lengths of

the axes and the font sizes used will be altered.

• When text objects are changed in this way, the height

and breadth of the corresponding text frame change,

as do the font sizes used.

With the keyboard Resizing with the mouse is often too inaccurate. In such

cases it can help to enter position and size numerically in the

unit of measurement selected. To do this, select the function

Position and size… under Position-> in the object’s context

menu.
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Multiple objects If you are going to enlarge the entire chart or parts of it,

you first have to combine them into one group as it is not only

the dimensions of the individual objects that can change but

also their position.·

• Pressing the ESC key when enlarging will cancel the

operation in exactly the same way as for moving ob-

jects.

Rotating and distorting objects

The warp tool in the tool bar is used for distorting objects

and can thus be used for giving the impression of perspective.

When you select an object after selecting the warp symbol, the

sizing handles are shown as hollow rectangles. You can change

the position of the handles with the mouse or the arrow keys

and thus distort objects as required.

The rotation tool in the toolbar is used for rotating objects

manually. When you select an object after activating the rota-

tion symbol, you will only see four sizing handles and cross-

hairs within a circle to show the center of rotation. You can

move the sizing handles with the mouse and thus rotate the

object around its center point. You can also move the center of

rotation with the mouse (or arrow keys).

In the Arrange menu the option Rotate by… allows you to

specify the Rotation point and the Steps for the rotation angle

under Rotate manually. These settings apply when using

the rotation tool!

Locking objects – better safe than sorry

When a chart starts to get very complicated, you may soon

find that the wrong objects are changed. To prevent this hap-

pening, you can lock individual objects or groups (but not,

however, automatically generated chart objects). Locked ob-

jects cannot be changed. You can recognize locked objects by

the fact that they only have two transparent sizing handles!
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Under Position-> in the context menu of a selected object

you will find the option Properties… . Here you can protect an

object against any changes with the function Lock . You can

find more on Properties… in the section on Object types.

You can also decide in the Page menu whether locked

objects are to be displayed or not. Locked objects or groups

of objects will then be shown as a frame containing a cross.

This function speeds up the display, in a similar manner to the

outline mode and saves considerable time, particularly when

you are carrying out detailed work at various zoom settings.
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Arranging Objects

In practice you will want to create an attractive layout

with the objects in graphics and charts. You will find the

functions available in Xact for arranging objects of great assi-

stance in this task.

Foreground or background

When working, you will notice that the last objects you

draw cover those drawn earlier. You can alter this sequence of

drawings provided you are not dealing with chart objects. To

do this, open the context menu of a selected object. There,

under Position-> , you will find four functions for changing the

order of the drawings (these can also be accessed via the

Arrange menu):

• Foreground and Background bring an object to the very first

or last place in the order of drawings.

• Bring forward and Send backward take an object one place

forwards or backwards in the order of drawings.

Positioning

You are no doubt familiar with the options available for

arranging and aligning text from experience with word-proces-

sing. A comparable function – except that it relates to graphics

items – can be found under Align… in the context menu of

objects (or in Arrange in the main menu). Here you can specify
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the position of selected objects or groups relative to one

another. The following passage deals with the Align dialog and

later on you will find some examples of different ways of

aligning. The functions Space evenly horizontally and vertical-

ly refer to the centers of the objects, whereas Center of page

horizontally and vertically refer to the middle of the page.

When creating the figure below, we used the function Lock

(in the context menu under Position/Properties… to prevent

movement of the objects with which the others were to be

aligned.

Further positioning aids

In complex charts the aligning function shown above will

often not be enough. In many cases it is more convenient to use

the functions shown in the Moving objects section in order to

lock objects or make help objects out of them. Help objects are

shown on the screen and are saved but not printed. You will

find the latter two functions under Position-> and then Proper -

ties in the context menu for the objects. Read the section on

Object types to find out more.

Left Center Right

Top Center Bottom
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Only in Xact Pro...

A range of special functions are included in the Xact Pro version:

CMYK - color space

You can select the CMYK - color space in

the File menu under Preferences/Graphics

editor/Color space... . Imported vector

graphics will then be automatically conver-

ted into the CMYK color model, but not,

however, bitmap graphics!

Copying XGF files...

If you often have to use Xact graphics files with charts on different computers or

want to copy or move them to other directories, you will find the function Copy

files. in the File menu of great use. It copies or moves Xact graphics files

together with their accompanying linked tables, and at the same time changes

the paths in the links for the chart. Therefore when copying, you do not need to

know which tables are linked to which charts. To monitor this, a logfile is

written in the accompanying dialog Copy

XGF files with linked tables.

The Select Graphics files button in this

dialog calls up the easy-to-use selection

box for graphic files described in the secti-

on entitled Reusing and Automating Docu-

ments. Xact Pro enables you to save the

data selected in lists and reuse them for

repeated copying, printing or export acti-

ons whenever you need them.
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Import filter for SHP files

This import filter allows you to read in and

process map material that has been stored

in the SHP format from the ESRI com-

pany. To do this, select Shape File Format

as the File type under Import. .

If present, the accompanying object na-

mes, which are usually stored together

with the Shape Files, will also be read in

and allocated. This function is used espe-

cially in combination with the Change ob-

ject styles option in the Chart menu.

Example: Chart Type “Change Object Styles”

This chart type changes the optical properties (fill color or shading density,

color or thickness of lines) of vector graphics objects according to numbers. Here

the entire contents of an Xact graphics window are imported into any other Xact

window. Graphics objects with names will not be changed optically unless the

names are also in the corresponding Xact table. All other graphics objects will

be copied at the same time without any changes.

Using the import function (File menu) or the clipboard, you can copy foreign

graphics objects, for example maps, into an Xact window and name them. The

import function is also able to read so-called shape files (*.SHP).

Let us demonstrate this procedure using a simple example – a map. The

graphics file used GERMAP.XGF and the accompanying table GERMAP.XTF

can be found in the directories that are created during the installation proce-

dure: GRAPHICS and TABLES.

Page 146 Only in Xact Pro...



Step 1: Naming graphics objects

The graphics objects to be changed first have to be given names. This

requires opening the context menu by clicking the right-hand mouse button on

an object. Here you select the entry for the object properties dialog under the

Position-> option. In this dialog you can give the object a name in the field after

Change to.

You can also give several objects the same name – these will then be treated

in the same way in the chart. Similarly, you can give groups of objects a

name – all objects belonging to the group will then be treated in the same way

within the chart.

Step 2: Writing names and figures in tables

The names of the objects have to be entered in

column 0 (Legend) of an Xact table from row 1.

Every row that is named in this way can then

have a numerical value in an adjacent column. If

no value has been entered, the object will not be

changed. The appearance of the object will be changed at a later stage regard-

less of this value. The column with the numerical values has to be defined as

type L Y1.

The simplest way is to let the objects be named automatically. To do this, select

the option List object names in the Object menu.

You will obtain a table which lists the names of all

the objects found in column 0. This list is arran-

ged in alphabetical order and does not contain

any duplicates, even if several objects in the

graphics file have the same name. For other pur-

poses you can switch off both the Keep drawing

order and Include duplicates function.

We have had the names, as described previously,

printed to the table in the adjacent figure from a

graphics file GERMAP.XGF (in the GRAPHICS

directory). You will find the table with the names,

GERMAP.XTF, in the TABLES directory. It con-
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tains the current boundaries of the German Federal states. We have then

allocated figures randomly to each state.

In the next step we selected the option Change object styles… in the Chart

menu. This opens up the Change object style dialog shown below:

Selecting a file with named objects…

After clicking on this field, select the graphics file which contains the objects

with names matching the table. In this case the file GERMAP.XGF is selected.

Afterwards further settings can be selected in the dialog:

• Change in objects: Line styles: Depending

on the numerical values in column L Y1 of the

table, you can change the Line width or Line

color of objects. Fill styles: You can change

the Fill colors, Hatch distances or charac-

teristics of the Dot matrix in objects accor-

ding to the numerical values in column L Y1

of the table.

We have chosen the setting Change fill styles.

After we have entered OK, our map chart ap-

pears in the document selected, New graphics.

As we had selected a dull gray in Preferen-

ces/Fills, Xact has also proposed that the areas

should be shaded gray.

The objects are retained in the chart, with their

names. In contrast to other chart types, you

cannot therefore call up the graph options via

the context menu of the shaded graphics ob-

jects. Instead, select the Chart options… entry

from the Chart menu or the Graph options…

entry in the context menu of a legend object.

Changes to these options made in this way al-

ways affect all the listed object-names for the

chart. We would now like to familiarize you
2 4 6 8 10 12 14 16
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with some additional settings on this ’raw

chart’. To do this, click the right-hand mou-

se button on a legend object to open the

context menu for the chart. Select Graph

options… , and the adjacent dialog will ap-

pear. It consists of two pages, here only the

first page, Division, is shown.

The settings that can be made are the nu-

merical limits for the chart, including the Step size and the Scaling (linear or

logarithmic). The divisions of the accompanying legend also vary according to

these settings. Under Start style… you can set the color that is allocated to the

lowest numerical value- the starting value, and under End style… the style

allocated to the final value. The intermediate styles (here: colors) are generated

automatically by Xact.

On the second page Options: you can specify whether the style of the objects is

to be grouped in classes (the class width

is determined by the preset step width).

In this way all objects with numerical

values between two steps receive the

same style, hence in this case the same

color. If Style setup as gradation is chek-

ked, all objects with numbers between

the starting and finishing values will

automatically be given a corresponding

intermediate style. If this switch is not

checked, any style can be used for each

step of the legend. This allows you to

choose any color you like to highlight a

particular step.

The style would then be set in the con-

text menu of the corresponding legend

object via the Fill style… option. That is

precisely what we have done for the fol-
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lowing chart – in step ”6” under Fill style… we have selected checked hatching

with a 45° angle.

In the Chart menu, under Caption…, we selected At object center under Place-

ment and under Font we checked Font color automatically.

OK causes all the object names to be written in the center of the respective

objects. As in some positions the white text overlapped the edge of the objects

and could therefore not be seen properly, we ungrouped the frame group in the

context menu of a descriptive object and shifted the lettering into place.

The completed chart is linked with the accompanying table. Hence any changes

in the values will result in corresponding style changes for the map objects.

Showing a further dimension…

In order to display a further numerical dimension within the same map,

several maps could be superimposed on one another, for example by allocating

a numerical value to the thickness of the outline. However, this depends on your

not yet having moved the first chart.

Here is an example of this technique: you want to have two different numerical

features displayed on a map. Basically this involves creating two different

charts, which are exactly superimposed. The lower chart, for example and as

shown previously, is given a covering fill color and the upper chart transparent

hatching. Here it is important the objects in the two charts have diffe-

rent names. For instance, if an object in the lower chart is called ”Bavaria” and

is displayed as a covering color, the upper shaded object must not be called

”Bavaria” as well. Objects with the same name are treated in the same way and

when the shaded object is created, the filled object that was already present

would also be shown as shaded. For this purpose you therefore have to use two

different graphics files with identical objects but different names, e.g. ”Bava-

riaF” and ”BavariaS”. Naturally the accompanying tables also have to have

different names.

Further ideas

There is a great variety of applications for this type of chart because, in

principle, every graphics object can be changed. By far the most familiar appli-

cation is the shading or coloring of maps, i.e. polygonal objects.
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Each of these object style charts can be used as the background for other

conventional charts, such as pie charts, bar charts and the like. To do this, when

you select from the Chart menu, simply click on a window with the object style

chart for In document, and then push the chart to the desired position.

Similarly it is also possible to change the thickness or color of lines. Another

example might be providing a clear presentation of quantities and sites of

substances moving within a system, such as a group of companies or an ecologi-

cal system. Here, for example arrows could be drawn at the various sites with

their direction indicating input or withdrawal, their color the category, and

their thickness the quantity. This would require drawing and naming colored

arrows. In the accompanying list of names (see oben) the quantities would then

be entered as numbers.

You have probably already realized that this type of chart offers quite

extraordinary opportunities for presenting complex relationships. Inci-

dentally, there is nothing to prevent you using Xact to place further charts on

these objects.
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City Block Charts

In some cases extremely complicated relationships can only be made com-

prehensible for the reader by using a graphic representation. Frequently the

data are divided into different charts because there is no suitable form for

presenting all the data together. With this type of chart you can display up to 5

different grades of characteristic on any number of objects. The underlying

metaphor will be easily understood by most people.

Each object is represented by a ”block of houses” in an imaginary town.

The position of the block is determined by its ”street” and ”house number”.

Every block has a specific and comparable ”appearance” because its shape is
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determined by the height, depth and width. How is a chart like this created?

We have prepared a sample table for you with the name CITYBLOC.XTF in the

GRAPHICS directory. In analogy to what was said above, it contains appropria-

te column names and four ”house numbers”. The columns have already been

suitably defined by clicks in the Types line. Under Bars… in the Chart menu we

then selected the type City-Block.

The results we obtained are displayed below. We shall now show you how to

proceed from this chart to the display at the beginning of this section:

In the context menu of the ”Wall

Street” graph we selected Capti-

on, and Above the object for Place-

ment and set the Spacing to 4mm.

Under Font in Fill style… we

checked covering as the Fill type

and selected white as the Color.

We then set the Fill styles… to

suitable gray values in the context

menus of the graphs, the base and

the rear wall.

In the context menu for the chart we chose Just text as the type under Legend… ,

for Frame we checked None and under Font style… we set the Size to 14 pt.

After clicking on OK in the dialog, we ungrouped the frame group for the legend

in the context menu of the Legend and moved the lettering to appropriate

positions with the mouse.
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After this, we went to the context

menu of the ”Madison Avenue”

graph and under Graph opti-

ons… we checked Horizontally

for Grid lines: and Use for all

identical graphs.

We then changed the presentati-

on mode of the vertical axis. To

do this, we opened the Axis se-

tup… dialog in the context menu

for this axis and unchecked Mir-

ror axis and In front on the Sca-

ling page. On the Ticks page we set the Style… for Grid lines to continuous.

Finally, we wanted to demonstrate the options for changing the spatial

arrangement of the chart. To achieve this effect, we selected 3D-presentation…

in the context menu of the chart and entered the settings for Rotation, Vanis-

hing point and Light source shown in the figure.

To Export the chart (File menu) as an EPS with preview we checked Embed

fonts (you can never be sure that the print setter will have the fonts to hand…).

In the DTP software we loaded the image into a frame – and that is how it

reached you.
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A Simple Object Chart

In this exercise we want to show you how to create a highly informative and

appealing chart. We want to depict the quarterly turnover figures for a service

provider, divided into cash turnover (till receipts) and invoices.

We shall use an object chart for this in which stacks of coins will represent

the cash receipts, and wads of banknotes the invoiced receipts. A bar chart will

form the basis for this object chart. The bars can then be replaced later by the

required symbols. At this stage you can decide whether the height and/or width

of the symbols should be adjusted or whether they should be stacked instead. In

this case we are going to try stacking.

Generally you can either fit symbols into the background of a 2D chart or

replace the markers of a line graph with symbols.
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First open the table file MONEY.XTF

from the GRAPHICS directory. Do

this by selecting Open table… from the

File menu and then choosing the file

you want from the list.

To create a bar chart from the file you

have loaded, select the Bars… option

from the Chart menu. Click on the

chart type Rows 2D and exit the dialog

with OK. The adjacent chart serves as

the basis for the object chart.

The next step is to replace the bars by

symbols. The symbols that we want to

use, a coin and a wad of banknotes, are

already present in the symbol library

supplied. Please open the list of instal-

led symbol libraries in the Object menu

under the Symbols… option. Now choo-

se Stackable symbols and exit the dia-

log with OK.

Select the banknote symbol from the

window with the mouse and, keeping

the left-hand button pressed, drag it

onto the legend for Invoice . As an ori-

entation aid, Xact places a frame

around the chart group on which the

mouse is currently located. As soon as

you let go of the mouse button, Xact

will recalculate the chart.

After recalculation the chart will in fact contain the wads of notes selected, but

they are much too large and look strangely distorted. The reason for this is that

Xact assumes you want to fit the symbol yourself. However, the coin and

banknote symbols are better suited to vertical stacking.

To switch to Stacking, move the mouse onto the wad of notes in the legend and

open the context menu by pressing the right-hand mouse button. Selecting the
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Symbol option opens up the corre-

sponding dialog. Check the option

Stack vertically and enter 76 % for

Offset as the wads should overlap a

little.

This offset, which is intended for 3D

symbols, depends on the shape of the

symbol. The offset causes an optical

illusion which only works for symbols

drawn with perspective. For two-di-

mensional symbols it is therefore bet-

ter to have an offset of 0%. OK in the

dialog will give you the desired piles of

banknotes.

We notice the frame around the wads

still exists, as we hah framed bars in

the beginning. Open the context menu

for the wads graph, select Line/Fra-

me... and All Graphs and uncheck

Draw line in the dialog.

Now insert the coins from the symbol

library into the second row of data,

with an offset of 65%. For the crow-

ning glory, open the Axis setup for the

X axis and uncheck the Angle auto-

matically box on the Labels page and

set the Angle to 45 degrees. You will

obtain the chart at the beginning of

this section.
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Creating Portfolios

The portfolio chart type is an established part of data presentation in the

economic sciences, market research and in general commercial applications.

Business consultants introduced this form of graphic representation in the

seventies, as a strategic method of analysis. Today portfolios have largely

established themselves in this field.

All portfolios are based on processed data, which have been evaluated and

compiled according to type. This data processing is decisive for the validity and

reliability of the portfolio. A key feature of modern portfolio methods are

variables compiled from a large number of weighted characteristics: e.g. a

”costs” variable which is made up of a wide range of weighted cost factors. A

distinction is made between Boston, ADL and McKinsey portfolios. These me-

thods of calculation will not be further elaborated upon at this stage. The

necessary mathematical operations can be carried out in the Xact table editor.
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The data that have been properly prepared and compressed produce a table

with three columns (an X, Y and Z column) and at least 2 rows. The X and Y

columns – as is familiar from the other chart types – are plotted on the X and Y

axes and so they determine the position of the circles displayed in the portfolio.

The values of the Z column determine the diameter or the area of the circles.

Here, with the aid of a set of data calculated according to McKinsey, we want to

show how a chart evolves from the table. To do this, open the table MK-

KINSEY.XTF by clicking on Open table in the File menu and selecting this file

from the TABLES directory. You will see the following image on the screen:

We are concerned here with dis-

playing important economic indi-

cators. To be precise, six indu-

strialized countries are being

compared in terms of three char-

acteristics. The columns have al-

ready been selected in the table:

the ”unemployment rate” in co-

lumn 1 has been assigned to the

X axis (marked X1 in the type

line), the ”inflation rate” is plotted on the Y axis and the characteristic ”rise in

GNP per capita” as the Z column will determine the areas of the circles.

• Portfolio charts always need an X, a Y and a Z column!

Please select the option Special… from the Chart menu and then Portfolio from

the Special charts dialog. The result – regardless of your preferences – will look

something like the following figure. In the context menu of one of the objects on

the X axis we have adapted its length to that of the Y axis, moved the automat-

ically generated lettering ”Area of the circles” into the chart with mouse and set

the Font size in their context menus.

The dotted lines show the arithmetic means of the X and Y columns calculated

by Xact. You can specify the Position and Line style of these lines, for example,

on the Help lines page in the dialogs of the X and Y axes as required. You can

also switch off these help lines or use additional help lines in this dialog.
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Changing the chart

First set the lengths of the X and Y axes

to 55 mm. A double-click on any object in

the axis concerned will bring up the axes

dialog. Please set the appropriate length

here and exit the dialog with OK.

Now call up the Chart options dialog.

Click the mouse on the number after Ma-

ximum diameter and enter ”15 mm”. As

we only want to see the outlines of the

circles, deactivate Filled circles by clik-

king on the box. To use these settings for

all graphs, check For all symbols. Confirm the settings with OK and exit the

dialog.

• Each individual circle in a portfolio can be replaced by any symbol from one

of the symbol libraries. To do this, drag a symbol from out of the symbol libra-

ry onto one of the circles. The replaced symbol adapts to the size of the circle.

You can also read up on this in the section entitled A Simple Object Chart.

If you wish, you can now alter the fonts for the title and sub-headings. A double

click on the title opens the title dialog box where you can select the text, font

and alignment in the context menu.
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Changing the lettering

We notice that automatically created lettering protrudes beyond the edges

of the smaller circles. It would look better if the lettering were above or below

the circles, depending on the available space.

In the Captions (chart context menu) you will see many options for automat-

ically positioning the lettering. In many cases the options in this dialog will

suffice. However, the captions created cannot be moved individually by hand

unless the groups with the captions have been unlocked. But then afterwards

the chart can no longer be changed with the chart functions.

Therefore we will opt for another solution: we shall first check No caption

under Placement. Then we open the Legend options in the chart context menu

and select Next to chart as the Legend type and check Just text. For Frame we

select None. After OK has been entered, the legend letterings are lined up next

to the chart. In the context menu, for the legends we click on Ungroup frame

group and can now select the lettering we wish to move, and position it at will

by keeping the mouse button pressed.

Depending on the application and target group, you can still refine the

design of the chart with the tools of the graphics editor, by importing logos and

other external images. But we are going to leave that to you! You will find our

version at the start of this section.
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Creating a Population Pyramid

We would now like to take you through creating a so-called population

pyramid. Basically this figure consists of two charts drawn ’back to back’. They

therefore have a common vertical X axis and two mirror-image horizontal Y

axes. Each chart contains two graphs (here ”men” and ”women”), the order of

drawing the graphs in the two charts is reversed. The graphs themselves have

a step-like curve.

Xact offers you two chart types for performing this task: you can choose

between Lines/Stepped areas (rectangles placed next to each other with a
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common frame) or Bars/Histograms or Bars/Rows (each bar has its own fra-

me).

The data table

Let us first consider the data so that we can make the correct choice of chart

type. The data supplied (see GERPOPLN.XTF in the GRAPHICS directory,

original data from the German Federal Statistical Office) consist of counts

(frequencies) per year of age (class) for each sex. It is therefore stipulated that

precisely one figure has been gathered for each year of age. As far as the graphic

representation is concerned, this means that the same frequency is present

from the start to the finish of one year of age, and so the graph created must

remain constant from beginning to end. Then at the beginning of the next year,

the frequency (usually) changes – at this point there is a ”jump” in the graph.

The graph style selected must therefore accurately depict these features. To

achieve this aim, Xact offers the chart styles already named above, and, of

these, we shall choose the chart type Lines/Steps area.

We have already prepared the accompanying data as a table. Open the file

GERPOPLN.XTF in the GRAPHICS directory. The table is read as follows:

column 1 (age in years) records each age class. In columns 2 (male) and 3

(female) you will see the corresponding

frequencies in thousands.

Values are available for the ages from 1

to 99. The last step begins at the age of 99

and continues to the age of 100. There are

no more data at the age of 100 and the

stepped curve should stop here, too. To

make sure that the steps can be drawn at

the correct height, we enter the frequency

of 0 for the age of 100 in both columns 2

and 3.

The population pyramid has a common

axis in the middle for the two sub-charts from which the age can be read. This

is the X axis of the two charts – in this particular case it is positioned vertically

as a horizontal display is selected. We therefore define the column Age in

years as X1 with a mouse-click in the Types row. We begin the figure with the
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chart overleaf, and here the graph for the Female column is covered by the

Male column. Consequently, we first define (as before) the Male column as Y1

because the column with the lowest number is drawn last, and covers the

previous column. Then the Female columns is defined as Y2.

Creating the charts

The table is now fully prepared. We then select Lines… in the Chart menu,

and there the type Steps area. We check horizontal and deactivate Frame. After

OK, Xact draws a step diagram in accordance with our Preferences in a newly

opened graphics window. Push the diagram, with the mouse button depressed,

into the right-hand half of the graphics window – because we still need room for

the second step diagram, which we plan to place next to it! Push the legend onto

the diagram too.

To create the second chart, first bring the table window back into the fore-

ground. In the left-hand chart (see figure at the start of this section) the step

diagram for Female is in the foreground and covers the graph for the Male

column. We therefore reverse the order of definition for the two columns.

Female is defined as Y1, Male as Y2. First we have to delete the previous

column definitions (the chart created previously has memorized its own defini-

tions) and redefine them. You can do this in two ways:

• To delete the previous columns definitions keep clicking on them until they

are no longer defined.

• You click the right-hand mouse button on the definition and choose None un-

der Column type in the context menu.

Next open the option Lines… in the Chart menu. Xact has remembered your

previous settings. As we want to draw this chart in the same window as the

previous, we now select the name of this window in the drop-down list that

appears next to In document. After you have left the dialog with OK, the window

New graphics 1 will appear in the foreground and the mouse-pointer will now

have the shape of a right angle. This indicates the upper left-hand corner of the

future chart frame. Place the mouse pointer to the left of the existing chart and

give a brief click on the left-hand mouse button. The chart will be then be drawn

at this position.
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Our results so far can be seen

besides. However, we have al-

ready changed some of the set-

tings in the right-hand chart so

that the appearance matches

our original conception: we want

to see grid lines actually lying

on the graph at the points where

the axes of the step diagrams

are labeled (and not the long

dashes, called ticks in Xact).

For this we select Graph opti-

ons… in the context menu. In the

dialog (see figure below) we

check Vertically under Grid li-

nes (as the chart was drawn ho-

rizontally, these lines will then

be horizontal). By checking Use

for all identical graphs, we en-

sure that these lines are drawn

on both step curves. After pres-

sing OK, we see in the figure

that the lines are dotted – but

we want continuous lines. These

lines follow the grid lines of the

vertical X axis in style, therefore

we have to change the style in

the Axis dialog. The style of the

vertical axis has to be changed

in any case.

Therefore we first open the Axis setup… in the context menu for the vertical axis

of the right-hand chart (Fig. 2).

On the Scaling page we reverse the counting sequence of the axis with a click on

Start<->End and enter the length as 160 mm. On the Division page, we enter a

0 for Number of subticks between ticks. On the Ticks page (see figure on this
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page) we set the length to

0 mm, under Grid lines/Style…

we select a continuous Line

type. On the Labels page we set

the Settings for: Ticks to Align:

centered.

We also need to deal with the

horizontal axis: under Axis se-

tup…/Scaling we enter a

Length of 50 mm, on the Division page we deactivate Start/division automat-

ically and specify a Step size of 100. On the Ticks page we deactivate the On box

for the Grid lines. On the Axis title page we have changed the Position of the

text, on the Labels page under Font… we have selected the Size as 8 pt.

In the context menu of each graph we have set the Fill style… black and 20%

gray.

In the next step we are now going to apply these same characteristics to the

left-hand chart. We are going to use the pipette tool for this, which is in the

toolbar on the left of the graphics window. This enables us to transfer all the

characteristics from one axis to

another of the same type. Click on the

pipette icon and the mouse pointer will

change to an empty pipette. Point it to an

object on the Y axis (e.g. a number) and

give a short click. The pipette is now full,

point to an object on the Y axis of the

left-hand chart. With one mouse click you

now transform this axis.

Do the same with the vertical axis! Then

change the counting sequence for the lo-

wer left Y axis, as described previously.

The two charts (Fig. 3) now look fairly

reasonable. However, the right-hand ver-

tical axis is superfluous, so we shall make

it invisible. On the Scaling page of the
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axis dialog, deactivate the box for Draw line under Axis presentation/Line

style… . On the Labels page, under Settings for: Ticks, click off Show. Finally,

delete the text entry on the Axis title page.

All of the previously visible items on the X axis have now become invisible. The

axis line is still there, but no longer visible. (If you click on Outlines only in the

lower control bar of the window, you can render all the objects that are present

visible!)

Now we transfer the fill style of the graphs in the right-hand chart to the left –

just as for the axes, using the Pipette switch on the vertical grid lines of the

graphs.

Assembling the charts

The two charts now have to be mounted on a common baseline. Click for a

moment on the line tool in the toolbar on the left (sixth from the top, see also the

section on Creating objects). Three symbols fan out to the right, choose the

middle one for a horizontal line and draw a line near the horizontal axes. Place

the line at the background of the chart using Background in the Arrange menu.

Now move the mouse pointer to the lower left-hand corner of the right-hand

chart. The mouse pointer changes into a

solid circle and thus shows that the vertex

of an object is located beneath it. With the

mouse button depressed, move the chart

onto the horizontal line. The mouse poin-

ter will change to a hollow circle, showing

that a line lies beneath it. Release the

mouse button and the corner of the chart

will be sitting exactly on the line.

Use the same procedure to move the left-

hand chart onto the line. Correct the hori-

zontal position of this chart by shifting it

with the arrow keys and –, so that the

numbers on the vertical axis are posi-

tioned centrally. Read up the section on

Selecting and Moving Objects to find
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further facilities for mounting graphics objects!

In the meantime the Axis title of the vertical axis has become invisible

because the left-hand chart is lying on top of it. Open the Axis title page in the

Axis setup and change the Position to perpendicular centered. The text is still

not positioned correctly, we shall push it into the appropriate position with the

mouse. The text is part of the Frame group of the chart which we can Ungroup

in the context menu. When ungrouped, all the group components are selected.

However, we only want to select the text. If you click the mouse to the side of the

chart, all the selections will disappear, and you can then click on the text and

push it into the desired position with the mouse or the arrow keys.

The legends are superfluous. Check the No legend box under Legends… in

the context menu of each chart. Some labels are still missing: use the text tool

to write these (the T in the toolbar on the left). Alter the size of the selected text

as required in the context menu of an object under Font… .

Finally, draw a rectangular frame around the figure using the rectangle

from the toolbar on the left of the window. It will hide all the objects so set the

Fill style… in the context menu of the object to Unfilled. Our result is at the

beginning of this section.

And if the figures change ?

Each of the two charts is linked with the original table. Therefore every time

a chart is recalculated, the data will be loaded from this table and used for the

chart. You can find a summary of the links for each chart in the context menu

under Links… .

If you change a figure in the table, you can click on Recalculate in the Chart

menu for the pyramid diagram. The figures in the table will then be used

according to the original column definitions and selection. You can read up on

this in the section Reusing and Automating Documents!
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Regression and Fits

Apart from descriptive functions, Xact also provides you with analytical

tools, which can be accessed in the context menu for a graph under Mathem.

procedures->. If you select the Regression/Fits option, the following dialog will

open with its numerous possible settings. After you have pressed OK, the

corresponding curve will be drawn. You can then change the appearance of the

curve in the context menu. In the following, the word fit will be used as a

synonym for regression. Here is a brief summary of the functions of this dialog:

• Methods: Here you

can set the type of fit.

Linear, Polynomial fit

or Non-linear fit are

the options available.

Selection of the latter

is discussed later in

the Non-linear fit Dia-

log.

• Fit range: Here you

can specify the range

of the X values from

which values are to be

used for the fit. The

curve calculated will

then be drawn in this

range.

• Minimize by: All of the methods attempt to place an ”optimum” curve

through the measured values. Three types of calculation are available for de-

termining the optimum, depending on the method you choose. In Least squa-

re the sum of the squares of the deviations is minimized, all the data

values are entered into the optimum with the same weighting. In contrast,

Absolute deviation minimizes the sum of the absolute deviations – so that
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more distant values are weighted less strongly. This applies to an even grea-

ter extent in the Lorentz method: here the distances of the values are evalua-

ted in a non-linear procedure according to the Lorentz transformation.

The two latter methods are therefore suited to lessening the influence of so-

called ”outliers” on the optimum.

• Use weighting: If weightings exist for the measured value (e.g. known er-

rors), they can be employed in most methods. The weightings must then be

placed in a column defined as the Dev column.

• Results: Here you decide where the numerical results are to be displayed.

For In window the results are displayed cumulatively in a specially opened

graphics window so that when several fits have been attempted, these can be

assessed at leisure, edited and then used for further purposes. For As additio-

nal legend a legend with the results is created next to the chart.

• Use for all identical graphs: Normally a fit is only calculated for the se-

lected graph. If this switch is active, the fit is calculated consecutively for

all graphs in the chart.

For the Show data option of a fitted graph (context menu under Extras-> or in

the Chart menu), the residues and fitting formulas with the parameters used

will be among the figures printed in a table for further processing. Refer also to

the Online Help under the heading Statistical characteristic values for fits.

You can find detailed information in the Online Help under the heading Regres-

sion.

Non-linear fits

If you have selected Non-linear fits in the Regression/Fits dialog and entered

OK, the Non-linear fits dialog shown on the next page will open up. It is divided

into the following sections:

Fit range (X-Axis):

Here you can specify the range of the X-axis from which values are to be used

for the fit. This range will also be used if you check the Show example box.
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Select formula:

Here you can select your Own: or Fixed: formulas from the drop-down lists. The

selected formula is displayed in the line f(x)= . If the formula (as do all fixed

formulas) contains display parameters, a graph of it is shown in the sample

image of the dialog. You can also use the parameters for the display in your own

formulas (see below). You will find further details in the Online Help under the

heading Sample image for fit formulas. If you enter a new formula in the line

f(x)= (up to 10 parameters), you will be able to import these into your own list

with the switch Add f(x) to list . Delete from list removes the selected formula

from the list.

Start parameters for selected formula

Here you enter the start parameters necessary for a non-linear fit as well as any

step sizes for the selected formula. A suitable starting value must be entered

after the corresponding letter (a,b,c…) for each parameter (a,b,c…) of the selec-
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ted formula. For non-linear fits, suitable starting values are nearly always

necessary in order to achieve a useful match for the values. If the value 0 has

been entered as Step size, the Start value of the parameter will not be

altered by the fit and will be used directly in the formula. Even if the

switch Estimate before fit is active, the start value entered will not be altered by

an estimate!

• Estimate now: If you have chosen a fixed formula, you can have suggestions

made for the start values (see above) of the fit for the selected graph by chek-

king this box.

• Show example: Clicking on this box will cause a sample image with the cur-

rently selected start values to be displayed. In addition the graph of the cur-

rent set of data will be shown as a blue curve in the image. This is

particularly useful if you either want or have to specify the start values ma-

nually with difficult fit problems and a large number of parameters! You will

find further details in the Online Help under the heading Sample image for

fit formulas.

• Use results from last fit: Unfortunately not every fit with the selected start

parameters and abort criterion is successful straight away. If you can already

see an approximation to your graph in the last fit, it may be helpful (particu-

larly in the case of the simplex fit) to use the determined parameters as start

values for the next attempted fit.

Fit method:

• Levenberg-Marquadt: This very fast algorithm is only suitable for the Least

squares method of minimization.

• Simplex: This relatively slow algorithm is very easy to manage. If you have

selected either Absolute deviation or Lorentz distribution under Minimize

by:, this will be the only algorithm open to you.

• Fit several times: To obtain a meaningful result, it is sometimes better to re-

start a fit once more with the values found after reaching the abort criterion.

This box activates the appropriate mode.
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• Estimate before fit: If you have chosen a fixed formula, you can have suggesti-

ons generated for the start values (see above) of the fit for every graph by

checking this box.

Abort after:

Here you specify the abort criterion for the fit. If one of the two following criteria

is met, the fit procedure will be terminated.

• Error: The fit procedure terminates if the minimization of the deviations from

the data to the curve only changes by an amount smaller than the value set.

Numbers smaller than 10^-11 would serve no purpose here because the com-

puting accuracy is approximately 10^11!

• Iterations: Here you can specify how many iterations are required before the

fit definitely terminates – after all, you do not want to sit in front of the com-

puter for an eternity if the algorithm does not find an end point.

How fitting works

Non-linear fitting is an iterative process and hence the start value and step size

are important parameters for controlling the iteration. Consequently, both

values are needed for each of the parameters sought. The start values lay down

the values of the parameters (a, b, c, …) at the beginning of the ”trial”.

In simplex fits the initial step sizes indicate the amount by which the start

values are to be changed at the start of the iterations. In Levenberg-Marquadt

fits this is not necessary.

The following applies to both methods: If step size=0, the preset start value will

be adopted without change by the fit method and thus used directly in the

formula.

At the beginning of the fitting procedure, the figures entered for Start values are

employed for every X value in the selected formula. Xact records the deviation

of the calculated values from the original values as the result. (In simplex fits

the start values of the parameters are changed by the preset step sizes in the

next iteration and the formula is recalculated.)
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The new result is compared with the previous one and, according to whether

there has been an improvement or deterioration, the parameters are altered

further.

This process is continued so as to achieve an improvement in the result. If a

change in the parameters leads to no further improvement (the change is then

smaller than the Error entered), the fit will be aborted.

While the curve is being fitted, a small dialog box provides a continuous display

of the iterations and the result (chi-squared).

If during computation the number entered after Iterations is reached, the

calculation will in any case be terminated.

You can find detailed information in the Online Help under the heading Dialog

‘Non-linear fit’.
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